
Inspection with Creo
Elements/Direct 2D Access

Windows User Interface
Creo Elements/Direct 2D Access 20.1



Copyright © 2020 PTC Inc. and/or Its Subsidiary Companies. All Rights Reserved.

User and training guides and related documentation from PTC Inc. and its subsidiary companies (collectively
"PTC") are subject to the copyright laws of the United States and other countries and are provided under a
license agreement that restricts copying, disclosure, and use of such documentation. PTC hereby grants to the
licensed software user the right to make copies in printed form of this documentation if provided on software
media, but only for internal/personal use and in accordance with the license agreement under which the
applicable software is licensed. Any copy made shall include the PTC copyright notice and any other
proprietary notice provided by PTC. Training materials may not be copied without the express written consent
of PTC. This documentation may not be disclosed, transferred, modified, or reduced to any form, including
electronic media, or transmitted or made publicly available by any means without the prior written consent of
PTC and no authorization is granted to make copies for such purposes. Information described herein is
furnished for general information only, is subject to change without notice, and should not be construed as a
warranty or commitment by PTC. PTC assumes no responsibility or liability for any errors or inaccuracies
that may appear in this document.

The software described in this document is provided under written license agreement, contains valuable trade
secrets and proprietary information, and is protected by the copyright laws of the United States and other
countries. It may not be copied or distributed in any form or medium, disclosed to third parties, or used in any
manner not provided for in the software licenses agreement except with written prior approval from PTC.

UNAUTHORIZED USE OF SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL
DAMAGES AND CRIMINAL PROSECUTION.

PTC regards software piracy as the crime it is, and we view offenders accordingly. We do not tolerate the
piracy of PTC software products, and we pursue (both civilly and criminally) those who do so using all legal
means available, including public and private surveillance resources. As part of these efforts, PTC uses data
monitoring and scouring technologies to obtain and transmit data on users of illegal copies of our software.
This data collection is not performed on users of legally licensed software from PTC and its authorized
distributors. If you are using an illegal copy of our software and do not consent to the collection and
transmission of such data (including to the United States), cease using the illegal version, and contact PTC to
obtain a legally licensed copy.

Important Copyright, Trademark, Patent, and Licensing Information: See the About Box, or copyright
notice, of your PTC software.

UNITED STATES GOVERNMENT RIGHTS

PTC software products and software documentation are “commercial items” as that term is defined at 48 C.F.
R. 2.101. Pursuant to Federal Acquisition Regulation (FAR) 12.212 (a)-(b) (Computer Software) (MAY 2014)
for civilian agencies or the Defense Federal Acquisition Regulation Supplement (DFARS) at 227.7202-1(a)
(Policy) and 227.7202-3 (a) (Rights in commercial computer software or commercial computer software
documentation) (FEB 2014) for the Department of Defense, PTC software products and software
documentation are provided to the U.S. Government under the PTC commercial license agreement. Use,
duplication or disclosure by the U.S. Government is subject solely to the terms and conditions set forth in the
applicable PTC software license agreement.



PTC Inc., 121 Seaport Blvd, Boston, MA 02210 USA



Contents

Preface ......................................................................................................................7

Getting Started with Creo Elements/Direct 2D Access....................................................8
About Creo Elements/Direct 2D Access..................................................................9
Starting Creo Elements/Direct 2D Access...............................................................9
The Creo Elements/Direct 2D Access User Interface...............................................9
Switching Languages..........................................................................................10
Switching to the Classic User Interface................................................................. 11
Switching the Beeper On or Off............................................................................12
Basic Working Methods.......................................................................................12
Exiting Creo Elements/Direct 2D Access ..............................................................19
Customizing Creo Elements/Direct 2D Access ......................................................19

Finding, Loading, and Handling Files ..........................................................................20
Using the File Browser ........................................................................................21
Creating a New Creo Elements/Direct Drafting Instance ........................................23
Opening an Existing Drawing File in a New Creo Elements/Direct 2D Access
Instance .........................................................................................................24

Using the CATALOG Command to List Files .........................................................24
Importing Macros, Fonts and HPGL Files .............................................................27

Viewing Drawings in Creo Elements/Direct 2D Access .................................................29
Using View Functions..........................................................................................30
Using Viewports to Display Several Views ............................................................31
Selecting What is Displayed on Your Screen.........................................................35

Measuring in Creo Elements/Direct 2D Access............................................................38
Changing the Catch Mode ...................................................................................39
Measuring Distances ..........................................................................................40
Setting the Units of Measurement ........................................................................43
Using the Calculator............................................................................................44
Using the Ruler/Grid ...........................................................................................44

Parts ........................................................................................................................48
Parts Structure ...................................................................................................49
Producing a Parts List .........................................................................................50
Showing Unselected Parts as Boxes ....................................................................50
Viewing Parts .....................................................................................................51
Part Browser ......................................................................................................52
Spotlighting Parts ...............................................................................................54

Viewing Hidden Lines ................................................................................................55
Introduction to Hidden Lines ................................................................................56
Checking Z-Values..............................................................................................57

4 Inspection with Creo Elements/Direct 2D Access Windows User Interface



Generating Hidden Lines.....................................................................................58
Showing Hidden Lines On/Off..............................................................................59
Showing Hidden Lines as Dashed Lines ...............................................................59
Plotting Hidden Lines ..........................................................................................59

Using Construction Geometry ....................................................................................60
Creating Construction Lines ................................................................................61
Drawing Construction Circles...............................................................................63

Revision Checking ....................................................................................................66
Using Revision Checking.....................................................................................67

Using URLs with Creo Elements/Direct 2D Access ......................................................69
Adding URLs......................................................................................................70
Changing URLs ..................................................................................................70
Deleting URLs ....................................................................................................70
Listing URLs.......................................................................................................71
Highlighting the Element or Part to which a Given URL is Attached.........................71
Accessing a URL ................................................................................................72
Using the URL Dialog in Show .............................................................................72
Switching URLs On & Off ....................................................................................72
Assigning a Color to a URL..................................................................................72
Further Information .............................................................................................73

Linking and Embedding OLE Objects..........................................................................74
Inserting an OLE Object ......................................................................................75
Editing an OLE Object in Creo Elements/Direct 2D Access ....................................76
Using the OLE Browser.......................................................................................77

Creo Elements/Direct Annotation................................................................................79
Introduction ........................................................................................................80
Loading a Creo Elements/Direct Annotation Drawing.............................................82
Using the Sheet Browser to Navigate among Sheets and Views.............................82
Views.................................................................................................................83
Showing Differences in a View Following a 3D Change..........................................84
Changing Hidden Line and Tangent Line Colors and Linetypes ..............................84

Printing and Plotting ..................................................................................................85
Using the Print Manager......................................................................................86
Creating a Print Configuration..............................................................................86
Defining the Print/Plot Settings ............................................................................88
Previewing a Print/Plot ........................................................................................97
Starting a Print or Plot Job ...................................................................................97
Printing or Plotting Multiple Drawing Files .............................................................97
Dumping the Creo Elements/Direct 2D Access Screen ..........................................98
Further Information .............................................................................................99

Customizing the Creo Elements/Direct 2D Access User Interface ............................... 100
Displaying and Hiding Menus............................................................................. 101
Editing Toolbar Items ........................................................................................ 101
Creating Custom Menus.................................................................................... 102

Contents 5



Creating Icons .................................................................................................. 106
Adding Icons to the Toolbar ............................................................................... 106
Defining Key Commands................................................................................... 106
Displaying Menus and Dialog Boxes via Mouse Buttons ...................................... 107
Displaying Dialog Boxes Directly........................................................................ 108
Managing Layouts ............................................................................................ 109
Converting Existing Multi-Column Menus ........................................................... 109
Resetting the Layout ......................................................................................... 109

Appendix A.Tutorial ................................................................................................. 114
Loading the Drawing ......................................................................................... 115
Creating Viewports ........................................................................................... 115
Placing Detail Areas in the Viewports ................................................................. 116
Measuring a Detail ............................................................................................ 118
Using the Show options..................................................................................... 119
Plotting a Drawing............................................................................................. 120
Tutorial Complete ............................................................................................. 121

Appendix B.Customizing Creo Elements/Direct 2D Access......................................... 122
Customizing the Creo Elements/Direct 2D Access Environment ........................... 124
Converting Binary Files to ASCII files ................................................................. 125
Writing Macros ................................................................................................. 126
Customizing the Keyboard ................................................................................ 128
Loading and Listing Text Fonts........................................................................... 129
Customizing the Startup File.............................................................................. 131
Creo Elements/Direct 2D Access Command and Function Names........................ 132
Creo Elements/Direct 2D Access Keywords........................................................ 138
Creating Menus ................................................................................................ 151
Adding Icons to the Toolbar ............................................................................... 152
Creating Multi-Column Menus ........................................................................... 152

Index...................................................................................................................... 155

6 Inspection with Creo Elements/Direct 2D Access Windows User Interface



Preface

Creo Elements/Direct 2D Access is a screen-only View and Plot facility for
integration within an existing CAD system. The Creo Elements/Direct 2D Access
software allows you to easily access any Creo Elements/Direct Drafting format
2D drawing.
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About Creo Elements/Direct 2D Access
Creo Elements/Direct 2D Access provides a full set of commands for viewing,
measuring, and plotting any MI format drawings created in the Creo Elements/
Direct Drafting 2D CAD system. In Creo Elements/Direct 2D Access, you cannot
damage or alter such drawings in any way.
To familiarize yourself with Creo Elements/Direct 2D Access, it may be a good
idea to complete the tutorial provided in Tutorial on page 114.
The functionality of Creo Elements/Direct 2D Access is a subset of the Creo
Elements/Direct Drafting functionality. For further details and illustrated examples
of this functionality, refer to the Creo Elements/Direct Drafting User's Guide
supplied on the Creo Elements/Direct Electronic Manuals CD.

Starting Creo Elements/Direct 2D Access
To start Creo Elements/Direct 2D Access, click:
Start ▶▶ All Programs ▶▶ PTC ▶▶ Creo Elements Direct 2D Access [version].

Note
Be sure that the License Server is running before you start Creo Elements/
Direct Drafting. See your Installing and Configuring Creo Elements/Direct
Drafting manual for instructions.

The Creo Elements/Direct 2D Access User
Interface
The Creo Elements/Direct 2D Access user interface is designed to ensure a short
learning curve. The following figure illustrates the general (default) layout of the
Creo Elements/Direct 2D Access user interface.
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Figure 1. The Creo Elements/Direct 2D Access User Interface

1 The top menu bar. This menu bar provides access to menus such as File and Setup.
Optionally, you can use hotkeys to select menu items.

2 The toolbar. Move the cursor to each of these icons to display the associated tooltips.
3 Viewing-related menus.
4 The drawing area. This is the area where you will view and modify drawings. Additional
viewports can be created in this area.

5 The bottom menu bar (which includes the Status Line). The first two items in this menu bar
reflect the current cursor position.

6 The prompt line. This line tells you how to proceed to complete the current operation.
7 The user input line. When prompted, enter the required input (such as a numerical value or
a name) into this line.

Optionally, you can run multiple Creo Elements/Direct 2D Access instances
(separate Creo Elements/Direct 2D Access windows) at the same time. Refer to
Creating a New Creo Elements/Direct Drafting Instance on page 23 for further
information.

Switching Languages
By default, the Creo Elements/Direct 2D Access user interface is displayed in
English. To switch to the language of your choice, enter the appropriate command
in the user input line:
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Language Command
English

change_locale 'en'

French
change_locale 'fr'

German
change_locale 'de'

Italian
change_locale 'it'

Spanish
change_locale 'es'

Japanese
change_locale 'ja'

Alternatively, specify this command above the Startup_menus string in the
startup.m file contained in the Creo Elements/Direct 2D Access installation
directory.

Note
The Japanese version of Creo Elements/Direct Drafting requires a Japanese
operating environment. If you installed Creo Elements/Direct 2D Access in
Custom mode, any languages you deselected during installation will not be
available at Creo Elements/Direct 2D Access runtime.

Switching to the Classic User Interface
Optionally, you can run Creo Elements/Direct 2D Access using the Classic User
Interface. Note that a separate User's Guide is available for this user interface.
To run the Creo Elements/Direct 2D Access Classic User Interface, you need to
set the following variable in the me10.ini file (located in the Creo Elements/
Direct Drafting installation directory):
MEPELOOK=2 Creo Elements/Direct 2D Access uses the standard Windows

style user interface.
MEPELOOK=3 Creo Elements/Direct 2D Access displays any top-level menus

in the usual Windows style (without the arrow indicating
cascading), whereas menus cascaded from the right-hand
menu bar are displayed in the "classic" style. Optionally, you
can enter the WUI_CLASSIC command into the user input
line to remove the separator lines from the "classic" style
menus in this display mode.
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Switching the Beeper On or Off
Optionally, you can switch the "beeper" on or off in Creo Elements/Direct 2D
Access. Simply enter BEEPER ON or BEEPER OFF into the user input line.

Basic Working Methods
You can quickly and easily delete elements or entire classes of elements from your
drawing for visual clarity. The Select options help you to select or unselect given
classes of elements.

Deleting Elements
Click Delete to delete drawing elements or pieces of text.
For example, to delete everything in the active part:

1. Click Delete.
2. Click All.
3. Click Confirm.

Highlighting Elements Before Deletion
The Select mechanism enables you to select the elements that you want to delete
(or modify).

1. Click Delete.
2. Click Select followed by any option or combination of options described

below.
3. When you are satisfied that the elements to be deleted have been correctly

selected, click Confirm.

Global Selection
Each time you select components, you can decide whether you want to select from
the current part or from the whole parts tree. Global selection allows you to select
components from the whole parts tree:

1. Click Select.
2. Click Global.

If you do not click Global, Creo Elements/Direct 2D Access defaults to the
current part.
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Example
Click Delete, Select, Global, All, Confirm, Apply.
This command string deletes all components of the parts tree even if the active
part is not the top part.
It should, however, be noted that even though all components (geometry,
construction geometry, and text) contained within the parts tree will be deleted, it
is not possible to delete the complete parts tree. The current part is never deleted
and a path linkage to the top part is always maintained.

Selecting Drawing Elements
Click Select to let Creo Elements/Direct 2D Access know you are about to make a
selection. Then press any option or combination of options from the selection
block.
All options on the selection block can be chosen directly without clicking Select.
However, if you do not click Select first:

• The elements you choose will not be highlighted on the screen for you to view
before the operation of your choice. For example, deleting will be performed
immediately.

• You will not be able to use the options Add, Subtract, Not, and so forth.

Note
If you want to select elements drawn in a particular color or linetype, you must
first click Select and then specify the respective color or linetype.

Example
1. Click Delete, Select; Color.
2. Select Green from the Color menu.
3. Click All, Confirm, Apply.

This will delete all elements drawn in green in the current part.

Adding Elements to Your Selection
This option allows you to add elements, either selected individually or enclosed in
a box, to your current selection. For example:

1. Click Delete.
2. Click Select.
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3. Select several elements to be deleted.
4. Click Add.
5. Click Box.
6. Enclose further elements to be deleted in a box.
7. Click Confirm.
8. Click Apply.

Subtracting Elements from Your Selection
To subtract elements from your current selection, click Subtract.

Removing Elements from Your Selection
Click Not to make the previous selection result unselected, and all previously
unselected elements to be treated as selected.

Note
Not always works globally on all parts.

Enclosing Elements in a Box
To select a group of drawing elements by enclosing them in a box:

1. Click Box.
2. Enclose the required elements in a box.

They will then be shown in a different linetype and Creo Elements/Direct 2D
Access prompts you to Confirm that you want to delete them. Before you click
Confirm, you may want to alter your selection by, for example, subtracting or
adding some elements.

3. Click Confirm.
4. Click Apply.

Enclosing Elements with a Polyline
If you need greater flexibility when selecting elements, use Poly to enclose
elements within a polyline. This is particularly useful when elements are not
symmetrically grouped horizontally and vertically.
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Figure 2. Selecting Elements with Polyline

Suppose you want to delete the elements 1, 2, and 3:

1. Click Delete.
2. Click Poly in Select.
3. Click a succession of points to define the enclosing polyline around elements

1, 2, and 3.
4. Close the polygon by clicking the start point again or enter CLOSE.

Selecting All Elements
To select everything contained in the current part (and subparts):

1. Click Delete.
2. Click All.
3. Click Confirm.
4. Click Apply.

Selecting a Vertex
Click Vertex in Select if you want to delete all elements that share a specified
point.

Selecting Elements by Type
The Select functionality facilitates the selection of specific element types in your
Creo Elements/Direct Drafting drawing.

Selecting Elements Using Information Strings
Click Info in Select to select all elements that have a particular information string
associated with them. You will be prompted to type in the information concerned.
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Selecting Layers
Click Layer in Select to select all elements assigned to a specified layer. When you
choose this option, the system prompts you for the layer information.

Selecting Text
Click Text in Select to select the required text. Creo Elements/Direct 2D Access
prompts you to identify the text to be selected.

Selecting Reference Lines
Click Ref Line in Select to select reference lines.

Selecting Construction Geometry
Click C-Geo in Select to select and highlight construction geometry. Alternatively,
click CCircle to select construction circles only or click CLine to select
construction lines only.

Selecting Drawing Geometry
Click Geo in Select to select and highlight drawing geometry. Alternatively, you
can:

• Click Line to select lines.
• Click Circle to select circles.
• Click Arc to select arcs.
• Click Spline to select splines.
• Click Fillet to select fillets.
• Click Point to select points.
• Click Poly El to select polyline elements.
To make a selection on pensize or linesize

1. Click Line Size or Pen Size in Select.
2. Enter a value (for example, 2).
3. Click Confirm.
4. Click Apply.

Selecting Parts
Click Part in Select to select elements in a particular part. Also, you can click
Subtree to select a subtree of a part or assembly.
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Example
To delete a selected part from anywhere in the parts tree:

1. Click Delete, Select, Global, Part.
2. Enter the part name.
3. Click Confirm.
4. Click Apply.

Note
When deleting a part, you automatically delete all associated subparts.

Selecting Dimensions
Click Dim in Select to select and highlight dimensions. Alternatively, click on Edit
Dim to select edited dimensions only.

Selecting URLs
Click URL in Select to select and highlight URLs.

Preselecting Elements
By preselecting elements, you can keep these available for subsequent operations.
Creo Elements/Direct 2D Access will "remember" your preselection until you
replace it by another preselection.
To preselect elements:

1. Click the Preselection icon in the Creo Elements/Direct 2D Access toolbar:

2. Select the elements you want to include in your preselection.
3. Click Confirm.
To retrieve your preselection:

1. Click PreSelected in the Select menu or in the Advanced select menu.
2. Click Confirm.
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Confirming Commands
Click Confirm to confirm that the deletion or modification you have defined
should be implemented.

Pasting Elements from Other Applications
Enables you to paste elements from other applications
into Creo Elements/Direct 2D Access.

Refer to Linking and Embedding OLE Objects on page 74 for instructions on
linking and embedding OLE objects in Creo Elements/Direct 2D Access.

Undo and Redo
In Creo Elements/Direct 2D Access, you can undo mistakes with Undo / Redo.

Click to undo an operation (before you click Confirm).

Click to redo an operation (after you have clicked Undo).

Each time you click Undo/Redo, you will undo or redo all the changes that were
created by the last command you entered.
You can set a limit on the number of steps to keep in the Undo or Redo history in
the System Setting dialog.

1. In the main menu, click Setup ▶▶ Edit Environment ▶▶ System.
2. You can select:

• -1: no limit.
• 0: disable the Undo/Redo option.
• +[number]: the maximum number of steps you can undo or redo when no

command is active. If you already have more steps in your history than the
number you selected as the limit, Creo Elements/Direct Drafting will
automatically delete the extra steps.

Limitations:
• You can undo or redo complete macros, but you cannot use Undo/Redo inside

macros.
• Undo or Redo cannot undo or redo:

○ Commands related to parametric design, hidden lines, PIXMAPs, or
OLEs. Once you have executed one of these commands, you can no longer
undo or redo any of your previous commands.
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○ The RESET_SYSTEM command.
○ Commands for default settings (although these commands do not affect the

undo/redo history).

Undo and Redo with state history
Each time you enter a command and change your drawing, Creo Elements/Direct
Drafting adds a new state to the undo/redo history. Creo Elements/Direct Drafting
marks the new state with a unique ID. With this information, you can:

• Use UR_GET_CURRENT_ID to see the ID of the current undo/redo state.
• Use UR_ID_EXISTS to see if a specified ID exists in the undo/redo history.
• Use UR_GET_FIRST_ID to see the ID of the first state in the undo/redo

history.
• Use UR_GET_LAST_ID to see the ID of the last state in the undo/redo

history.
• Use UR_MOVE to undo/redo the drawing to a specified state.

Exiting Creo Elements/Direct 2D Access
To exit Creo Elements/Direct 2D Access, pull down the File menu and click Exit.

Customizing Creo Elements/Direct 2D
Access
You can quickly and easily customize Creo Elements/Direct 2D Access for your
personal requirements. Detailed instructions are provided in the following HTML
format document on your Creo Elements/Direct Electronic Manuals CD:

/htm/english/viewer/appb.html
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This chapter assumes that you are familiar with the directory structure and general
file handling methods of your computer.
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Using the File Browser
You can open a drawing file quickly and easily by means of the Creo Elements/
Direct 2D Access File Browser. This File Browser adheres to standard MS-
Windows conventions. You do not need to remember long filenames and
subdirectories as these are displayed. (You can still enter the filename on the
command line if you wish.)
You can close the File Browser once the drawing has been opened or saved.
Optionally, you can leave the File Browser open for further selections.
In the File related dialog boxes, the File Browser provides the following icons:

Moves up one level in the directory hierarchy.

Creates a new folder (directory) on the current
directory level.
Displays columns of files and directories.

Displays files and directories in report mode. In this
mode, you can sort the listed files and directories by
type, size, last modification date/time and attributes.

In the dialog boxes associated with the File Browser, you can move, copy and
delete files and directory using standard MS-Windows techniques.

Opening a Drawing File via the File Browser
To open a drawing file by means of the Creo Elements/Direct 2D Access File
Browser:

1. In Creo Elements/Direct 2D Access, pull down the File menu.
2. Click one of the following options to display the File Browser:

Open The drawing file you select or specify will replace any
drawing already loaded in the Creo Elements/Direct 2D
Access workspace.

Load File The drawing file you select or specify will be added to any
drawing already loaded in the Creo Elements/Direct 2D
Access workspace.

3. Unless the file you want to open is listed in the file pane of the File Browser,
pull down the Directory selection list and change to the directory where the file
is stored. If this directory is specified in the file pane, double-click on the
directory name to list the files contained in it.

4. Optionally, select a mode in which to load the drawing file:
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As Subpart Loads a drawing as a subpart to a drawing that is already
loaded.

Absolute Loads the drawing back into the same position, relative
to the origin, from which it was originally stored.

Keep Scale The original drawing scale is retained when the drawing
file is loaded.

5. Click on the filename. If a file is provided in a format other than MI (the
default), pull down the Filter selection list and select the applicable format:

• Model Interface Standard (*.mi)

• Compressed MI (*.bi) (compressed by means of the Z-lib mechanism)
• Autodesk Drawing Interchange (*.dxf)

• Initial Graphics Exchange Format (*.igs)

• AutoCAD File Specification (*.dwg)

• Creo Elements/Direct Modeling Bundle (*.bdl) files. (Note that only the 2D
portions of such files are extraced, while any 3D portions are ignored.)

A preview image of the drawing file is displayed in the preview pane of the
File Browser.

6. Click Open to open this file in Creo Elements/Direct 2D Access. Alternatively,
enter the filename and press [Enter].

7. Once the drawing is displayed in Creo Elements/Direct 2D Access, you can
view and measure it.

Note
The preview image is pixel-based. It cannot be modified.

Opening a Drawing File by Means of the Navigator
The Creo Elements/Direct 2D Access Navigator provides a scrollable sequence of
preview images of the drawing files in the current directory. The Navigator thus
facilitates the selection of drawings.
To open a drawing file by means of the Creo Elements/Direct 2D Access
Navigator:

1. In Creo Elements/Direct 2D Access, pull down the File menu and click Open
to display the File Browser.

2. Click Navigator to display the Creo Elements/Direct 2D Access Navigator.
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3. In the left pane of the Navigator, switch to the directory whose drawing files
you want to view.

4. In the right pane of the Navigator, scroll down until you see the preview image
of the drawing file you want to open. Note that the Navigator displays a
preview image for each file provided in the formats listed above.

5. Double-click on the preview image to open its associated drawing file in Creo
Elements/Direct 2D Access.

6. Once the drawing is displayed in Creo Elements/Direct 2D Access, you can
view and measure it.

Note
To return to the File Browser, simply close the Navigator.

Opening Most Recently Used Drawing Files
By default, the four most recently used drawing files are listed (complete with
filetype extension) in the Creo Elements/Direct Drafting File menu. To load one of
these files:

1. Pull down the Creo Elements/Direct Drafting File menu.
2. Click on the name of the drawing file you want to load.

Creating a New Creo Elements/Direct
Drafting Instance
Optionally, you can run multiple instances of Creo Elements/Direct 2D Access at
the same time.
To create a new Creo Elements/Direct 2D Access instance:

1. In Creo Elements/Direct 2D Access, pull down the File menu and click New ▶▶
Window. Alternatively, click the following button in the Creo Elements/Direct
2D Access toolbar:
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Note
• Each instance will run in a separate window.
• All Creo Elements/Direct 2D Access instances are independent of each

other; there is no master or slave instance.
• Only a single Creo Elements/Direct 2D Access license is required for any

number of Creo Elements/Direct 2D Access instances run by the same user
on the same machine/display.

• Newly created Creo Elements/Direct 2D Access instances are initiated
without the input_customize command. Consequently, any additional
applications associated with a given Creo Elements/Direct Drafting
instance are available in that instance only. For example, if you run a
licensed third-party standard parts library in a Creo Elements/Direct 2D
Access instance, this library is not automatically available in another Creo
Elements/Direct 2D Access instance.

Opening an Existing Drawing File in a
New Creo Elements/Direct 2D Access
Instance
To open an existing drawing file in a new Creo Elements/Direct 2D Access
instance:

1. In Creo Elements/Direct 2D Access, pull down the File menu and click New ▶▶
Dwg in New Window.

2. In the file browser, switch to the appropriate directory.
3. Select the drawing file you want to load.
4. Click Open to load this drawing file in a new Creo Elements/Direct 2D Access

instance.

Using the CATALOG Command to List
Files
The CATALOG command enables you to generate a list of files in a directory:

1. Enter CATALOG into the user input line in Creo Elements/Direct 2D Access.
2. Specify the directory to be listed.
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3. Specify the applicable output option: SCREEN, APPEND, DEL_OLD, or prt
(printer).

Although this catalog only displays five catalog items, each file has eleven catalog
items:

• The filename, "FILE_NAME".
• The file physical name, "PHYS_NAME".
• The file size, "FILE_SIZE".
• The file type, "FILE_TYPE".
• The file description, "FILE_DESC".
• The file create date, "CREATE_DATE".
• The last file modify date, "MODIFY_DATE".
• The last file access date, "ACCESS_DATE".
• The number of accesses, "NUM_ACCESS".
• The program name, "PROGRAM".
• The program revision, "REVISION".

Generating Sorted Catalogs
There are many options and methods of producing different types of sorted
catalogs. This section describes the main methods. When you have sorted a
catalog, you can:

• Display the catalog on the screen.
• Print the catalog using a printer.
• Store the catalog in a file.
The first step in producing a sorted catalog is to enter the CATALOG command and
specify the directory you want to catalog. Creo Elements/Direct 2D Access then
prompts for the catalog option that will carry out the type of sort you want. The
catalog options include:

• Listing Files Contained in the Directory
• Sorting a Directory from Smallest Value to Largest
• Sorting a Directory from Largest Value to Smallest
• Selecting Items to Produce a New Catalog

Relational Operators
After you define the catalog item to select on, you need to enter a relational
operator. This relational operator specifies the sort operation to be performed.
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The following relational operators are available:

Character Meaning
= equal to (default operator)
<> not equal to
> greater than
< less than
>= greater than or equal to
<= less than or equal to

For example, if you want to find all files whose file size is equal to 3000 bytes,
you would enter:

"FILE_SIZE" = 3000

The catalog item is FILE_SIZE, the relational operator is =, and the item value is
3000.

Item Values
Item values are necessary when you produce sorted catalogs. You will need to
define the catalog item, the relational operator, and the item value for the sort.
When you enter an item value that contains letters, you must enter the item value
in 'quotation marks'. This is not necessary for item values consisting of digits only.

Wildcards
You can use wildcards when you define the item values for your catalog output.
Wildcards are special characters that perform additional exclusive selections.
Refer to the Creo Elements/Direct 2D Access Help for further details.

Sorting a Catalog
To sort the file catalog from smallest to largest or vice versa:

1. Enter CATALOG.
2. Enter the'name'of the directory you want to sort. For the current directory,

enter ''.
3. Enter SORT to sort from smallest to largest (sort up) or REVERSE_SORT to

sort from largest to smallest (sort down).
4. Enter a catalog item such as "FILE_SIZE", or "FILE_NAME".
5. Enter output option: SCREEN, DEL_OLD, APPEND, or prt (printer).
Creo Elements/Direct 2D Access sends the catalog to the defined output.
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Importing Macros, Fonts and HPGL Files
You can import the following files into your current Creo Elements/Direct
Drafting drawing:

• Creo Elements/Direct Drafting Macros
• Fonts
• HPGL Files

Importing a Creo Elements/Direct Drafting Macro
To import a Creo Elements/Direct Drafting macro:

1. In Creo Elements/Direct 2D Access, pull down the File menu and click Import.
2. Click Macro.
3. Click one of the following options:

Input to import a macro provided in ASCII format.
Load to import a macro provided in binary format.

4. Select the macro from the dialog box.
5. Click Open to open the macro.

Importing a Font
To import a font:

1. In Creo Elements/Direct 2D Access, pull down the File menu and click Import.
2. Click Font.
3. Click one of the following options:

Convert from TT/T1 to import a TrueType font provided in ASCII format.
Select a font from the dialog box and click Convert to
convert and load the font for use in Creo Elements/
Direct 2D Access.

Load to import a font provided in binary format. Select a
font from the dialog box and click Open to load the
font for use in Creo Elements/Direct 2D Access.

Specifying the Resolution of an Imported TrueType Font
To specify the resolution of a TrueType font you want to convert to a Creo
Elements/Direct Drafting font for use in Creo Elements/Direct 2D Access:

1. Enter the following command into the user input line:
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CONVERT_TO_ME10_FONT

2. Enter the desired resolution. Note that the maximum value is 255.
3. Enter the font name.

Importing an HPGL File
Creo Elements/Direct Drafting enables you to load HP-GL and HP-GL2 files. To
import an HP-GL (Hewlett-Packard Graphics Language) or HP-GL2 file:

1. In Creo Elements/Direct 2D Access, pull down the File menu and click Import.
2. Click Load HPGL.
3. Specify the name (complete with path) of the HP-GL file you want to import.
4. Specify the position for the imported HP-GL file.
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3
Viewing Drawings in Creo
Elements/Direct 2D Access

Using View Functions ................................................................................................30
Using Viewports to Display Several Views...................................................................31
Selecting What is Displayed on Your Screen ...............................................................35

This chapter describes how to view a drawing in Creo Elements/Direct 2D
Access.
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Using View Functions
This section shows how to control the area of the drawing shown in the current
viewport using the View functions.

Redrawing
Click Redraw in View to redraw the drawing in the chosen viewport. This is
sometimes necessary if you have deleted several elements and traces can still be
seen on the screen. The contents of other viewports will not be redrawn.

Fitting a Drawing
Click Fit in View to fit the current drawing into the chosen viewport.

Panning Across a Drawing
Panning is a very useful function enabling you to move across the drawing to see
those areas not currently displayed.
To pan in any direction:

1. Click Pan in View.
2. Click a point in your drawing.
3. Specify the new screen position for this point.
Alternatively, press the CTRL key, press the left mouse button, and drag the
cursor to pan to the new position.

Creating a New View in a Window
To create a new window:

1. Click New in View.
2. Specify the bottom left and top right corners of the area where you want to

create the new view.

Restoring the Last View
Click Last in View to return to the previous view.

Zooming In or Out
Awindow is always zoomed about its center point.
To zoom a view:
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1. Click Zoom in View.
2. Enter the zoom factor required.

A number greater than 1 results in a window that covers a smaller area
(zooming in). A number less than 1 (>0) or negative (<-1) gives a larger
coverage (zooming out).

3. Press [Enter].
Alternatively, press the [Ctrl] key and press the right mouse button. Move the
mouse towards the screen to zoom in, move the mouse away from the screen to
zoom out.

Storing and Recalling Windows
If you are likely to need the same view again, you can store it and recall it as
required:
Click Store in View to store the current window coordinates.
Click Recall in View to recall the window that was stored last.

Creating a New Center Point for Your Drawing
Click Center in View and specify the new center point for the display. Your
drawing is then repositioned so that this point is in the center of the chosen
viewport.

Note
This option uses the current catch mode to identify the specified point.

Using Viewports to Display Several Views
You can divide the drawing area of the screen so that more than one view can be
displayed. This is a very useful feature when you want to work on a detail
drawing. The changes made to the detail are automatically repeated in the main
drawing. Each division of the screen is called a viewport.
Viewports can be overlapped with other viewports. All viewports are continuously
updated.
In the following example, the view in viewport 1 can be imagined as the view you
would see if you were examining your drawing with a magnifying glass. To
achieve this effect, simply zoom in to the drawing displayed in viewport 1 until
you can see the required level of detail.
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• Viewport 1 — contains a magnified view showing the required level of detail.
• Viewport 2 — contains the entire drawing and is used as a positional reference

for the magnifying glass.
Examine the zoomed drawing in viewport 1 while moving the cursor (as a
positional reference) in viewport 2. See Figure 3. Using Viewport 2 as a Reference
on page 32 and Figure 4. Viewing Piston Assembly Detail in Viewport 1 on page
33.

Figure 3. Using Viewport 2 as a Reference
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Figure 4. Viewing Piston Assembly Detail in Viewport 1

Creating a Viewport
To create a new viewport:

1. Pull down the Setup menu.
2. Click Viewport and Create.
3. Specify a point for the top left corner and another point for the bottom right

corner of the new viewport.

The newly created viewport is marked by a sequential number in the top right
corner.

Making a Viewport Current
If a viewport is partially or totally covered by other viewports, it is made inactive.
Its visual contents will not be updated by any subsequent operations unless it is
made the current viewport.
The current viewport is the one that is currently active, fully visible and up-to-
date. The viewport number is displayed in inverse video in the top right corner.
To change the current viewport:

1. Pull down the Setup menu.
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2. Click Viewport and Current.
3. Click the viewport required. Alternatively, enter the viewport number and

press [Enter].

Changing the Size of a Viewport
To change the size of a viewport:

1. Pull down the Setup menu.
2. Click Viewport and Change.
3. Click the viewport.
4. Indicate the new corner points of the viewport.

Moving a Viewport
To move a viewport:

1. Pull down the Setup menu.
2. Click Viewport and Move.
3. Click the viewport.
4. Drag the cursor to the new position of the bottom left corner of the viewport.

The contents of the viewport follows the viewport.

Redrawing a Viewport
To redraw a viewport:

1. Pull down the Setup menu.
2. Click Viewport and Redraw.
3. Click the viewport.

The contents of the viewport will be redrawn.

Maximizing the Size of a Viewport
You can maximize the size of any viewport such that the viewport occupies the
entire Creo Elements/Direct 2D Access drawing area.

1. Pull down the Setup menu.
2. Click Viewport and Large.
3. Click the viewport.
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Any other viewport are now hidden begind the maximized viewport. To bring
any of these hidden viewport to the foreground, make it current. To change the
size of the maximized viewport, use Change.

Deleting a Viewport
To delete a viewport:

1. Pull down the Setup menu.
2. Click Viewport and Delete.
3. Click the viewport. Alternatively, enter the viewport number and press [Enter].

Deleting All Viewports
To delete all viewports:

1. Pull down the Setup menu.
2. Click Viewport and Delete.
3. Click Select ▶▶ All ▶▶ Confirm ▶▶ Apply.

To view your current drawing in Creo Elements/Direct 2D Access after you
have deleted all viewports, you need to create at least one new viewport.

Viewport Settings
The viewport settings are defined in the Viewport Settings dialog box.
To define the viewport settings:

1. Pull down the Setup menu.
2. Click Viewport and Settings.
3. In Viewport Settings, select the viewport border color and specify the viewport

border width. Select the background, text and cursor colors.

Selecting What is Displayed on Your
Screen
The Show dialog box is accessible via the Setup menu as well as from the right-
hand menu bar.
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Note
Before you plot your complete drawing, you are recommended to check what
is included by clicking Show All in Show.

You can selectively display or hide:

• Construction geometry
• Geometry
• Dimensions
• Hatch
• Text
• Vertex
• Info
• Layers
• URLs

Note
• The Show settings apply to the current viewport.
• Any new viewports created will automatically adopt the settings of the

viewport that was active when they were created.

Showing All Features
Click Show All in the Show dialog box to display all features of your drawing. It is
useful to start with everything displayed, then switch off what is not required.

Showing Points
Tick the Vertex check box in Show to display all existing points on the drawing.
This is useful if you want to identify a point more accurately, or to check if two
lines overlap. Points are displayed in the following colors (by default):

• GREEN— end points
• YELLOW— common end points
• BLUE — single center points
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• MAGENTA— multiple center points

Showing Dimensions
The Dimensions check box in Show enables you to turn all dimensions on or off.

Changing the Layer Color
To change the color of a specified layer.

1. Click the Layer tab in Show.
2. Select the layer number.
3. Select a color from the Color list.

Displaying Infos
1. Click the Info tab in Show.
2. Select the info to be displayed.
3. Click On to display elements that have information attached.

Setting the Redraw Mode
When dealing with large or complex drawings, you may want to change the
redraw mode in order to enhance the graphics performance.

1. Click Setup ▶▶ Edit Environment ▶▶ System.
2. In System, click on the Redraw tab.
3. Select one or any of the following settings:

• In the Parts as Box section, you can specify a size threshold (in pixels)
below which parts are only shown as boxes. This box representation hels
to unclutter your drawing display. Optionally, select a color from the Box
Color menu.

• In the Draw Dynamic section, check any items that you want to include in
the redraw. Uncheck any items you want to exclude from the redraw to
enance performance.

4. Click OK to save these settings.
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Measuring in Creo Elements/Direct

2D Access
Changing the Catch Mode..........................................................................................39
Measuring Distances .................................................................................................40
Setting the Units of Measurement ...............................................................................43
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This chapter describes how to measure in Creo Elements/Direct 2D Access. The
combination of Catch and Measure functions provides a powerful tool for fast and
accurate measurements.
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Changing the Catch Mode
The Catch function enables you to select a point on the screen without putting the
cursor directly on that point. The cursor will automatically "snap" to this point.
The current catch mode is always displayed in the System Status Line. The system
will catch to a given point only if the point lies within the (imaginary) circle
around the edges of the cursor.
By default, the Catch mode is set to All. You can change the Catch mode to any of
the following:

Setting Catches to
VERTEX Vertex
ELEM Element
INTERSECTION Intersection
CENTER Center point
GRID Ruler/grid point
OFF Switches Catch off

Simply click on the Catch arrow in the bottom menu bar to list these options for
selection.
When Catch is set to All, Creo Elements/Direct 2D Access will catch using the
following order of priority:

1. VERTEX

2. INTERS

3. RULER/GRID

4. ELEM

If the system finds a vertex within the catch range it catches to the closest such
vertex; otherwise it searches for intersections and so on. If the system can't find
any of these, it uses the given input point.

Setting the Catch Range
To alter the catch range:

1. Pull down the Setup menu.
2. Click Edit Environment and select System.
3. In the Cursor section of Environment, specify the new catch range.
4. Click OK.

Measuring in Creo Elements/Direct 2D Access 39



Measuring Distances
The Measure functions allow you to obtain values for arc lengths, distances, point
coordinates, angles, and areas. These functions are useful if you need to enter a
value measured from existing features on the drawing. To illustrate this, consider
the following example.

Example
Suppose you want to draw a vertical line starting at 100,100 and of the same
length as an existing line drawn at an angle of 40 degrees:

1. Pull down the Tools menu.
2. Click Measure and Length.
3. Click the existing line. The measured length of this line is displayed in the

User Prompt Line.
4. Click Line in Geometry.
5. Click Vertical in Line.
6. Specify the begin point of the vertical line you want to create.
7. When prompted for the end point or the length of this vertical line, simply

display the measured length in the User Prompt Line and press [Enter]. Creo
Elements/Direct 2D Access draws the vertical line as specified. The length of
this line is the same as that of the line you measured.

Note
• The ruler Follow function is not active during the Measure function.
• If any of the Measure functions are used within macros, the resultant

measurement will be stored and can be obtained by using the INQ function.

Measuring Lengths
Click Tools, Measure and Length to measure the length of any element (line,
circle, arc, fillet, chamfer or spline).
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Measuring Distances (Horizontal and Vertical)

Note
This option is dependent on the current catch mode.

1. Click Tools, Measure and Horizontal or Vertical.
2. Click two points in the drawing to identify the horizontal or vertical distance

to be measured.

Displaying Point Coordinates

Note
This option is dependent on the current catch mode.

To display the exact coordinates of any existing point:

1. Click Tools, Measure and Point.
2. Click the point. The exact coordinates of this point are shown in the User

Prompt Line.

Measuring Angles
To measure the angle between two lines:

1. Click Tools, Measure and Angle.
2. Click a point on the first line.
3. Click a point on the second line.
Similarly, to measure an arc segment angle, click the arc start and end points.
The angle between two tangents drawn at an intersection point of two circles can
be measured by clicking a point on the first circle and then a point on the second
circle.

Measuring a Radius
To measure the radius of a curved element:

1. Click Tools, Measure and Radius.
2. Click the curved element whose radius you want to measure.
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Measuring Area Properties

A Single Face
To calculate the area and area properties of a selected face, the face must be
completely bounded by elements.
Creo Elements/Direct 2D Access calculates and displays the following area
properties for a single face:

• Number of holes in the face.
• Density of the face.
• Perimeter length of the face (outer perimeter).
• Area.
• Center of Area (= Center of Mass).
• Principal Axes (of Inertia through the Center of Area).
• Second Moments of Area about principal axes.
• Second Moments of Area about coordinate system axes.
• Product of Second Moment of Area about coordinate system axes.
• Moments of Inertia about principal axes.
• Moments of Inertia about coordinate system axes.
• Product of Moment of Inertia about coordinate system axes.
• Section Moduli (about principal axes).
• Distance from first neutral axis to extreme fiber.
• Distance from second neutral axis to extreme fiber.
• Radii of Gyration.
• Angle between coordinate system and principal axes.

Multiple Faces
If you identify multiple faces, Creo Elements/Direct 2D Access uses the density
values to calculate the Common Center of Mass. The density must be specified
before a face is identified, otherwise the default value (1) or the previous density
value is used.
Creo Elements/Direct 2D Access calculates and displays the following total values
for multiple faces:

• Total Area.
• Center of Area (common).
• Center of Mass (common).
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• Principal Axes through the (common) Center of Area.
• Second Moments of Area about (common) Principal Axes.
• Second Moments of Area about Coordinate System Axes.
• Product of Second Moment of Area about Coordinate System Axes.
• Moments of Inertia about (common) Principal Axes.
• Moments of Inertia about Coordinate System Axes.
• Product of Moment of Inertia about Coordinate System Axes.
• Radii of Gyration with respect to the (common) Center of Area.
• Angle between Coordinate System and (common) Principal Axes.
To display face area properties:

1. Click Tools and Area Properties. Creo Elements/Direct 2D Access prompts
you to enter a density (default 1) or to select a face.

2. Enter the density value if known, otherwise select the face(s).
3. Click Confirm. The area properties are listed in a text box.
4. Optionally, you can save the list of area properties in a file.

Setting the Units of Measurement
You can select linear and angular units from the bottom menu bar. The current
units are displayed in the System Status Line. The following options are available:
Linear units:

• mm
• um (micrometer)
• inches
• feet
• yards
• miles
• mils
• uinches
• usr
Angular units:

• deg
• grd
• rad
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• usr

Defining Your Own Units
The usr option in the selection lists for angular and linear units allows you to
define your own units. For example, an input of 5mm allows you to work in 5mm
units, and an input of 5 degrees allows you to work in 5 degree units.

Using the Calculator
Creo Elements/Direct 2D Access provides a standard MS-Windows calculator. To
switch to scientific calculator mode, pull down the View menu in the top menu bar
of the calculator and select Scientific.

Using the Ruler/Grid
The ruler simulates the T-square traditionally used with manual drafting methods.
When used together with the grid point catch mode, the ruler allows you to draw
with the help of a grid.
The grid is a useful drawing aid for alignment purposes.

Displaying a Ruler and/or a Grid
To display the ruler and/or the grid:

1. Pull down the Setup menu.
2. Click Grid and Settings to display the Grid Settings dialog box.
3. Press the Dot or Line radio button below Grid to display a dot or line grid.
4. Press the Ruler radio button below Ruler to display a ruler.

Displaying the Origin
Press the Origin radio button in the Grid Settings dialog box. The coordinate origin
is indicated in the chosen viewport by an axes symbol. If the ruler is active in the
chosen viewport, it is switched off.

Setting the Cursor Size
You can use either a small cursor or a full screen cursor. A full screen cursor is
particularly recommended for use with the ruler.
To change the cursor size:
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1. Pull down the Setup menu.
2. Click Edit Environment and System.
3. In the Cursor section of the System dialog box, tick the Large check box to

switch to the large (full screen) cursor.
Note that the catch range is not affected by the cursor size. Optionally, you can
specify a catch range in the Catch Range field.

Using Follow On/Off
The ruler is always located at the origin. The origin always tracks the ruler, and
the ruler always tracks the origin. Optionally, you can use the Follow function to
move the coordinate system origin with the origin of the ruler.
To make the origin follow the ruler:

1. Pull down the Setup menu.
2. Click Grid and Follow.
The ruler will now automatically move to each new point you create.

Moving the Ruler
To move the ruler:

1. Pull down the Setup menu.
2. Click Grid and Move.
3. Specify the new origin. The orientation of the ruler axes will remain the same.

Rotating the Ruler/Grid

With Respect to the X-Axis
To rotate the ruler (or grid) so that the x-axis is at a given angle to the horizontal:

1. Pull down the Setup menu.
2. Click Grid, Turn and Absolute.
3. Enter the angle required.

Through a Given Angle
To rotate the ruler (or grid) through a given angle:

1. Pull down the Setup menu.
2. Click Grid, Turn and Relative.
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3. Enter the rotation angle required.

A positive value results in counterclockwise rotation.

Setting the Ruler/Grid Spacing
To change the spacing between the tick marks of the ruler or between the grid
lines or dots:

1. Display the Grid Settings dialog box.
2. Enter the required distance (for example: 0.5) into the Spacing field. Note that

this entry is interpreted in terms of the current length unit.
If the spacing is very small, it may not be shown on the screen but it will still be
used for catch when in ruler or grid catch mode. Use the View functions if you
want an enlarged view.

Drawing an Isometric Ruler/Grid
To redraw the ruler or grid according to the isometric grid required for drawing
top, front, or side views:

1. Pull down the Setup menu.
2. Click Grid and Isometric.
3. Select the applicable option:

• Top

• Front

• Side

Hiding the Ruler/Grid
To hide the ruler/grid:

1. Pull down the Setup menu.
2. Click Grid and Hide.
The Hide function switches the ruler and/or grid off. Alternatively, you can press
the None radio button in the Grid Settings dialog box.

Placing the Ruler/Grid
To change the orientation of the axes:

1. Pull down the Setup menu.
2. Click Grid and Place.
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3. Specify the new origin and two more points that define the new axis
orientation.

Figure 5. Ruler Axes on page 47 shows the ruler axes.

Figure 5. Ruler Axes
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Producing a Parts List................................................................................................50
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To understand how to use the Parts commands, it is necessary for you to have a
basic understanding of parts.
A complex drawing is likely to contain several parts. Design Engineers use parts
to simplify the drawing into clearly defined groups of elements. Each part has a
partname. It is possible to view or highlight only one part of a complex drawing at
a time. This provides a clearer visual representation of the part in relation to the
entire drawing.
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Parts Structure
The use of parts in a drawing results in a parts structure. A parts structure can be
thought of as a family-tree showing the relationships between all the parts. The
structure is hierarchical and has many levels, each level containing information
about the relationship between each part and its subparts. The highest level of the
parts structure is called Top. The lowest level contains parts that cannot be
subdivided any further.
If a part has subparts then it is called a parent part.

Summary
• Complex drawings are likely to contain parts.
• Parts are groups of elements.
• Each part has a name (partname).
• Parts containing subparts are called parent parts.
• You can selectively view, or highlight any part or group of parts, either by

means of the Part Browser on page 52, or by means of the following
commands.

Editing Parts
Three command options are available to edit parts: editing a part, editing a top
part, and editing the parent part. Creo Elements/Direct 2D Access displays the
active part in normal linetypes and colors while all the other parts are shown in
magenta dotted lines.

Editing a Part
To set a part as active:

1. Enter EDIT_PART
2. Enter the part name, or click an element of the part.
Creo Elements/Direct 2D Access sets the clicked part as the active part.

Editing a Top Part
To set the highest part in the parts structure as active, enter EDIT_PART TOP.
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Editing the Parent Part
As discussed earlier, parts can contain subparts. To set the parent of the active
subpart as the new active part, enter EDIT_PART PARENT

Producing a Parts List
Use the PARTS LIST command to produce a list of the parts in your drawing. The
list shows the relationship between the active part and all the other parts.
Creo Elements/Direct 2D Access can display the parts list on the screen, or it can
print the list on a locally-connected printer. The following instructions are for
displaying the list on the screen.

Counting Parts
Use the Count option to list all the parts one level below the active part and all the
parts owned by the active part. Before using this command, check that you have
the correct active part set. To list these parts:

1. Enter PARTS_LIST and then SCREEN.

Creo Elements/Direct 2D Access displays the list of parts in a separate text
editor window.

Producing a Parts Tree
Use the Tree option to produce a full parts list of the parts in your drawing. The
active part has a * next to it. The list displays the hierarchical relationship between
each part. This is shown by indentation of the part name. To produce a full parts
list:

1. Enter PART_LIST TREE SCREEN.

Creo Elements/Direct 2D Access displays the list of parts in a separate text
editor window.

Showing Unselected Parts as Boxes
Use the following commands to look at selected groups of parts. Creo Elements/
Direct 2D Access replaces each part not selected by a box. The command works
only in the active viewport. Using boxes is useful when parts overlap.

With Part
To draw a part as a box representation:
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1. Enter SHOW_PART.
2. Click on the part.
Creo Elements/Direct 2D Access redraws the part as a box. Also, use this
command to draw a boxed part as a normal part.

With All
To restore all parts to their normal appearance, enter SHOW_PART ALL.

With Part Boxed
To change a part and all its subparts to a box representation:

1. Enter SHOW_PART PART_BOX
2. Enter the parent part name, or pick an element of the parent part.
Creo Elements/Direct 2D Access redraws the parent part and all the subparts.

Viewing Parts
Use the View commands to look at individual parts of your drawing. The
command works only in the active viewport.

Viewing a Part
To look at an isolated part:

1. Enter VIEW
2. Enter the part name, or click on an element of the part.
Creo Elements/Direct 2D Access draws only this part. Creo Elements/Direct 2D
Access displays the part name in the top left-hand corner of the active viewport.

Viewing All Parts
To view all parts of a drawing, enter VIEW TOP.
Creo Elements/Direct 2D Access redraws all the parts making up the drawing.
Creo Elements/Direct 2D Access redraws the part name in the top left-hand corner
of the active viewport. This is useful if you have been viewing a lower level and
want to quickly redraw the drawing.

Viewing Parent Part
To view the parent of the currently viewed part, enter VIEW PARENT.
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Part Browser
To display the Part Browser, click Part Browser in Parts. To perform an action on
a given part, click on that part in the Part Browser, then press the right mouse
button to display a popup menu, and select an option from this menu. Note that
the Part Browser can be docked anywhere in the Creo Elements/Direct 2D Access
window.

What is Shown in the Part Browser?
The Part Browser provides a graphical overview of the current parts structure in
your drawing.

• Starting at the top part, this tree-like structure includes a separate branch for
each part. Subparts of a part are shown as sub-branches of that part.

• Click on the + (plus) sign icon to expand the tree.
• Click on the - (minus) sign icon to collapse the tree.
• Tick the (checkbox-like) state icon to the left of any part icon to view the

associated part (and any parts hierarchically below this part).
• Untick the (checkbox-like) state icon to the left of any part icon to hide the

associated part (and any parts hierarchically below this part).
The individual columns of the Part Browser provide the following information:

Column Description
Name Specifies the name of the part. The following icons are used

to indicate the nature of the part:

The currently active part. Note that the
currently active part is represented by a
red icon.
Normal part or assembly. Any non-
active parts and/or parts hierarchically
below the active part are indicated by a
green icon.
Shared part.

Detail.

The associated part is hidden. This is
because you have applied the View
command to another part.

Unique Specifies a unique sequential number associated with the
part.

Share A "hash" (#) character in this colums indicates that the part is
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Column Description
shared.

Scale Indicates the drawing scale of the part.
Symbol A small "x" indicates that the part is symbolic.

The Part Browser Tree Popup Menu
To display the Part Browser tree popup menu, press the right mouse button on any
part icon in the Part Browser. This popup menu provides the following commands
(some of which are also available via the Parts menu):
View Shows only the selected part. Creo Elements/Direct Drafting

fits this part into the current viewport. All other parts are
hidden, and their icons are marked by a yellow X (see list of
Part Browser icons above).

Symbol Changes the part to a symbol.
Show This command provides the following options:

Show Shows the selected part (if it
is presently shown as a box or
if it is hidden).

ShowFlat Shows the selected part but
not its subparts (if any).

ShowAll Shows the entire selected part
complete with all of its
subparts.

ShowBox Shows the selected part as a
box.

Hide This command provides the following options:
Hide Hides the selected part.
HideFlat Hides the selected part but not

its subparts (if any).
HideAll Hides the entire selected part

complete with all of its
subparts.

Options The Icons option enables you to display the Part Browser with
or without icons. The State Icons option enables you to show
or hide the (checkbox-like) state icons that indicate whether or
not a part is visible.
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Save You can click Save to save an ASCII representation of the
current parts tree structure in a Creo Elements/Direct Drafting
list file.

Delete Deletes the selected part.

Spotlighting Parts
You can distinguish between the active part and all other parts by using a
spotlight. The command is a simple On/Off switch. The SPOTLIGHT is on when
you first load Creo Elements/Direct 2D Access.

• To switch the spotlight off, enter SPOTLIGHT OFF.
• To switch the spotlight on again, enter SPOTLIGHT ON
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Viewing Hidden Lines

Introduction to Hidden Lines.......................................................................................56
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Generating Hidden Lines ...........................................................................................58
Showing Hidden Lines On/Off ....................................................................................59
Showing Hidden Lines as Dashed Lines......................................................................59
Plotting Hidden Lines.................................................................................................59
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Introduction to Hidden Lines
This chapter shows how to display hidden lines in assembly drawings.
The 2D hidden line module is used with assembly drawings to automatically
display lines that indicate hidden drawing features. In an assembly drawing, these
lines are normally shown dashed.
Click Hidden to access the hidden line menu.
Before you can display an assembly drawing using the hidden lines mode, you
must check to see that the faces of your drawing have been assigned z-values.

What are Faces?
Faces can be thought of as freely definable, infinitely thin, shaped areas that form
part of an assembly. Faces can partially obscure or completely cover other faces
and geometry lines (depending upon their z-values).
In simple terms, you could imagine faces as pieces of paper, laid one on top of
another, thus obscuring elements with a lower z-value.
Figure 6. Faces - With Z-Values 0 and 1. on page 56 shows the faces of two
components (one with z-value 0 and the other with z-value 1).

Figure 6. Faces - With Z-Values 0 and 1.

What are Z-Values?
A z-value is the numerical value assigned to an element to position it in the
drawing at the appropriate logical level in the z-direction.
See Figure 7. Visualizing Z-Values. on page 57.
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Figure 7. Visualizing Z-Values.

A face or line with a higher z-value covers a face or line with a lower z-value.
Figure 8. Z-Values 0, 1 and 2. on page 57 shows 3 faces assigned the z-values 0, 1
and 2.

Figure 8. Z-Values 0, 1 and 2.

Hatches are treated as faces, this means hatched areas can cover geometry and
faces. Hatches that are partially covered are displayed partially obscured.
Construction geometry, texts, leader lines and dimensions are always visible.

Note
A face does not necessarily need to have the same z-value as its boundary
lines. In this case the boundary lines of the face may be partially covered by
the face itself (solid lines may appear dashed in some cases). Note, the
linetype of the boundary lines is not changed.

Checking Z-Values
You can check the z-values of:

• Elements
• Shared parts
• Elements in shared parts
The z-value will be displayed on the User Prompt Line.
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Checking the Z-Value of an Individual Element
To check the z-value of an individual element:

1. Click Inquire Z Value in Hidden.
2. Click Absolute in Inquire Z Value.
3. Select the element.

Checking the Minimum or Maximum Z-Value in an
Assembly Drawing
To check the minimum or maximum z-value:

1. Click Inquire Z Value in Hidden.
2. Click Minimum in Inquire Z Value.

Checking the Z-Value of a Shared Part
To find the computed z-value of a shared part:

1. Click Inquire Z Value in Hidden.
2. Click ShPrtOffset in Inquire Z Value.
3. Select the shared part.

Creo Elements/Direct 2D Access computes the z-value as the sum of the
shared part's z-value and that of the shared parent part.

Checking the Z-Value of an Element in a Shared Part
To find the z-value of an element in a shared part:

1. Click Inquire Z Value in Hidden.
2. Click ShPrt Elem in Inquire Z Value.
3. Select the element in the shared part.

Generating Hidden Lines
When you click Change to Hidden to generate hidden lines, Creo Elements/Direct
2D Access does the following:

• Geometry is modified by splitting geometric components if they are covered
by faces with a higher z-value.

• Splines are converted.
• Shared parts are unshared.
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• The parts tree, starting from the current part, will be smashed.

Showing Hidden Lines On/Off
Once you have generated hidden lines, you can switch the hidden lines on or off
by clicking On or Off in Hidden Mode.

Showing Hidden Lines as Dashed Lines
With Hidden Mode switched on, you can display hidden lines as dashed lines by
ticking Show Hidden.

Plotting Hidden Lines
If you are plotting your drawing, note that it is not possible to plot face colors.
In order to suppress plotting of hidden lines you must set the hidden line linetype
and color appropriately. For more information, see the PLOT_
TRANSFORMATION command in the online help.
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7
Using Construction Geometry

Creating Construction Lines .......................................................................................61
Drawing Construction Circles .....................................................................................63

This section shows how to add construction lines and circles to a drawing
displayed in Creo Elements/Direct 2D Access. Construction geometry can be used
to check the alignment of existing geometry.
Construction lines differ from real lines in that they are considered to be of infinite
length. Only full construction circles can be drawn.
When creating construction lines you can either click positional points in the Creo
Elements/Direct 2D Access drawing area, or you can enter the coordinates
(separated by a comma) into the User Input Line.

60 Inspection with Creo Elements/Direct 2D Access Windows User Interface



Creating Construction Lines
The following commands allow you to draw construction lines.

Construction Line by Two Points
Click this option, then click two points for the construction
line required or enter the coordinates of two points.

Horizontal Construction Line
Enter the y coordinate of the line required, or click a point
through which the line must pass. To create several horizontal
construction lines, simply enter the appropriate y coordinates
separated by spaces.

Vertical Construction Line
Enter the x coordinate of the line required, or click an existing
point through which the line must pass. To create several
vertical construction lines, simply enter the appropriate x
coordinates separated by spaces.

Perpendicular Construction Line
You can create a construction line perpendicular to any existing
line. Click the option, click the existing line, and then specify a
point through which the perpendicular construction line must
pass.
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Parallel Construction Line
You can create construction lines parallel to any existing line in the
following ways:
• Click any existing line. Specify a point for the parallel

construction line to pass through. You can draw multiple parallel
construction lines by specifying further points for the lines to pass
through.

• Enter the required separation of the line. Then click any existing
line. Finally, click the side on which the parallel construction line
should be drawn. Multiple lines can be drawn at the previously set
separation by clicking the original lines and the desired sides.

• A set of parallel lines can be drawn from an original line. For
example, if you enter line separations in the form: 10 20 30 40,
four parallel lines will be drawn at the given distances from the
indicated line.

Construction Line Bisecting an Angle
You have the option of entering a value for the ratio of the
division, otherwise the angle will be bisected. Specify the apex,
and then specify two points (usually on existing lines) to define
the angle.

Construction Line at an Angle
When you select this option, Creo Elements/Direct 2D Access
will prompt you to specify a point through which the
construction line must pass. Next enter the angle of the line with
respect to the x axis. Note that a positive input will result in a
line drawn counterclockwise from the x axis. The angle units
will be those currenlty defined for your Creo Elements/Direct
2D Access environment.

Bisecting Construction Line
If you do not want the line concerned divided into two equal
parts, enter a value for the ratio of the division. Then specify the
two end points of the line. A construction line will be drawn
perpendicular to the line at the appropriate position.
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Construction Line Tangent from Point to Circle
This option enables you to create a construction line tangent to a
circle or a spline and passing through a given point or at a set
angle.
Click the approximate point of tangency on the circle or spline and
then specify a point through which the construction line must pass.
Or, click the approximate point of tangency, then enter the desired
angle of the construction line. Note that the angle is measured in a
counterclockwise arc from the horizontal.

Construction Line Tangent to Two Circles
You can create a construction line as a tangent to two circles or
splines. Click this option and click the approximate point of
tangency on each of the two circles or splines. The construction
line created will be the one with points of tangency closest to those
you indicated.

Drawing Construction Circles
Eight commands allow you to draw construction circles.

Construction Circle by Three Points
You can create a construction circle by specifying three points
on the circumference. Click this option and specify two
circumference points. The construction circle created will vary
with the movement of your cursor until you specify the third
point.

Construction Circle by Center and Circumference
Point

Specify the center of the construction circle and either specify a
point on the circumference, or enter the radius required. If
multiple concentric circles are required, specify multiple
peripheral points or enter the desired radii.
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Concentric Construction Circles
To create concentric construction circles, click this option and click
the existing circle. Enter the radial offset of the new construction
circle from the existing one, that is the difference between the two
radii. To create several concentric construction circles, simply type
in the appropriate radial offsets separated by spaces. Alternatively
you can click existing points through which the construction circles
must pass.

Construction Circle by Diameter
Specify two points as the two ends of the diameter for the
required circle.

Construction Circle by Radius, Point (or Two Points)
and Element

Click the approximate point of tangency of the construction
circle on the existing element. Next specify a point on the
circumference, then either specify another point or enter the
required radius.

Construction Circle by Center and Element
Click the approximate point of tangency on the existing element.
Next specify the center of the construction circle to be drawn.

Construction Circle by Radius or Point and Two
Elements

This option draws a construction circle of given radius
tangential to two existing elements. Click the approximate
points of tangency (either lines or circles). Next specify a
peripheral point on the construction circle or enter the desired
radius. Creo Elements/Direct 2D Access calculates the best
solution, or informs you that no solution is possible.
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Construction Circle by Three Elements
Click the approximate point of tangency of the construction
circle on each of the three existing elements.
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8
Revision Checking

Using Revision Checking ...........................................................................................67

This chapter tells you how to use the commands and options that allow you to
compare similar drawings. This facility is particularly useful in design offices
where successive drawings are revised and you need to identify the differences
between revisions.
The differences between the original and revised drawings are shown in color.
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Using Revision Checking
To use the revision checking facility, click Rev Check.

1. Click Load Files in Rev Check.
2. In the Load dialog box, specify the name of the original drawing file and the

name of the revised drawing file.

Creo Elements/Direct 2D Access displays the two drawings overlapping.
3. Click Geometry in Compare.

Creo Elements/Direct 2D Access compares the location of the geometry and
texts (without comparing the parts structure) in the two drawings and shows
the result of the comparison in different colors according to the following
defaults:
Blue Identical geometry elements in both drawings
Green Differences in the original drawing
Red Differences in the modified drawing

The other options in the Compare menu do the following:
Annotation In addition to Geometry, this option also compares the

properties of the geometry and texts — linetype, color, text
attributes, info texts — and the dimensions and hatches in both
drawings.

Parts In addition to Annotation, this option compares the parts
structure in both drawings.
If you modify a drawing solely by a scaling factor, clicking
Parts displays all elements in red (indicating a difference).
However, the options Geometry and Annotation displays
elements and annotation in blue (indicating identical elements).

Note
Both drawings must have the same location compared to the drawing origin to
get meaningful results from the comparison.

Viewing Single Drawings
When both drawings are loaded, you can toggle between them using View in Rev
Check. To display the original drawing only, click Original in View. To display the
revised drawing only, click Revised in View. To display both drawings, click Both
in View.
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Resetting Colors and Showing Differences
The colors generated after selecting an option in the Compare menu can be reset to
their original colors.
Reset Show Use this command to show the drawings in their

original colors.
Show Difference Use this command to show the drawing elements in

different colors, corresponding to the result of the last
comparison.

Changing the Color Scheme
To change the color scheme:

1. Click Color Settings in Rev Check.
2. Select the color for changes in the original drawing.
3. Select the color for changes in the revised drawing.
4. Select the color for identical elements.
The color changes take effect with the next redraw.
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9
Using URLs with Creo Elements/

Direct 2D Access
Adding URLs.............................................................................................................70
Changing URLs.........................................................................................................70
Deleting URLs...........................................................................................................70
Listing URLs .............................................................................................................71
Highlighting the Element or Part to which a Given URL is Attached ...............................71
Accessing a URL.......................................................................................................72
Using the URL Dialog in Show....................................................................................72
Switching URLs On & Off ...........................................................................................72
Assigning a Color to a URL ........................................................................................72
Further Information....................................................................................................73

Creo Elements/Direct Drafting enables you to attach any industrial standard Web
page to drawings, parts and elements. All URLs used by Creo Elements/Direct
Drafting drawings, parts and elements are handled via the URL dialog box
accessible from the Infos menu.
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Adding URLs
To add a URL to the current Creo Elements/Direct Drafting drawing or to a part or
to an element in the drawing:

1. Click URL in Infos.
2. In the URL dialog box, click Add.
3. In the Add dialog box, select the area to which you want to add a URL:

Current to add a URL to the current part
Element to add a URL to an element or a group of elements
Part to add a URL to a part other than the current part

4. Specify the URL in the Info field of the Add dialog box.
5. Click OK.
6. Unless you selected Current (the default area) in the Add dialog box, select the

part or element to which you want to attach the URL.
7. Click End.

Changing URLs
To change the URL attached to a part or element:

1. Click URL in Infos.
2. In the URL dialog box, click Change.
3. In the Change dialog box, select the area in which you want to change a URL:

Current to change a URL of the current part
Element to change a URL of an element or a group of elements.
Part to change a URL of a part other than the current part

4. Unless you selected Current (the default area) in the Change dialog box, select
the part or element whose URL you want to change.

5. Select the URL to be replaced from the old selection list.
6. Specify the URL you want to use instead.
7. Click OK.
8. Unless you selected Current (the default area) in the Change dialog box, select

the part or element whose URL you want to change.

Deleting URLs
To remove a URL attachment from a part or element:
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1. Click URL in Infos.
2. In the URL dialog box, click Delete.
3. In the Delete dialog box, select the area from which you want to delete a URL

attachment:
Current to remove a URL attachment from the current part
Element to remove a URL attachment from an element or a group

of elements.
Part to remove a URL attachment from a part other than the

current part

4. Select the URL attachment to be removed from the Info selection list.
5. Click OK.

Listing URLs
To display a list of the URLs attached to the current drawing or to a part or to an
element in the drawing:

1. Click URL in Infos.
2. Display the List selection list at the top of the URL dialog box.
3. Select the area whose URLs you want to list:

Global to list all URLs attached to any items in the current
drawing

Current to list all URLs attached to the current part
Element to list all URLs attached to an element or group of

elements
Part to list all URLs attached to a part other than the current

part

4. Unless you selected Global or Current, click Select in URL and select the part
or element(s) whose URLs you want to list.

The associated URL list is displayed in the URL dialog box.

Highlighting the Element or Part to which
a Given URL is Attached
To highlight the element or part to which a URL is attached:

1. Click URL in Infos.
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2. List the URLs attached to your drawing. See Listing URLs on page 71 for
instructions.

3. Select a URL from the list.
4. Click Show Elem or Show Parts to highlight the element or part to which this

URL is attached.

Accessing a URL
To access a URL attached to a part or element in a drawing:

1. Click URL in Infos.
2. List the URLs attached to your drawing. See Listing URLs on page 71 for

instructions.
3. Select the URL you want to access.
4. Click Browse to access this URL by means of your default Web browser or

navigator.

Using the URL Dialog in Show
Click on the URL tab in Show to display the URL dialog box.
In this dialog box, you can:

• Switch URLs on and off
• Box an area to show its URLs
• Select a color for each URL

Switching URLs On & Off
To switch URLs on or off:

1. Click Show in Setup.
2. Click the URL tab.
3. In the URL dialog box, select the URL you want to switch on or off.
4. Click On or Off.

Creo Elements/Direct 2D Access will now switch the specified URL on or off.

Assigning a Color to a URL
You can color a URL to aid visualization.
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To color a URL:

1. In the URL dialog box in Show, select a URL.
2. Select a color from the Color selection list.

Creo Elements/Direct 2D Access will indicate the URL in the newly selected
color.

Further Information
For further technical information about layers and infos, refer to the Creo
Elements/Direct 2D Access help system:
Enter help layer or help info or help url at the Creo Elements/Direct 2D
Access command line. The screen will clear and Creo Elements/Direct 2D Access
will display further information about using layers or infos or URLs with Creo
Elements/Direct Drafting.
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Linking and Embedding OLE

Objects
Inserting an OLE Object.............................................................................................75
Editing an OLE Object in Creo Elements/Direct 2D Access...........................................76
Using the OLE Browser..............................................................................................77

Files (such as spreadsheets, graphics or text pages) created in external applications
can be included in Creo Elements/Direct 2D Access by inserting associated OLE
objects.
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Inserting an OLE Object
To insert an OLE object into a drawing in Creo Elements/Direct 2D Access

1. In Creo Elements/Direct 2D Access, pull down the Insert menu and click
Object.

2. The Insert Object dialog box lists all applications on your system that provide
OLE capability.

3. Scroll down the list and select an application.
4. Select one of the following options by clicking the associated radio button:

• Create New

• Create from File

Create New
This option inserts a new OLE object of the selected application into your
Drafting drawing.
To create a new OLE object:

1. Select an object type from the Object Type list and click OK.
2. If you use the Display As Icon option, the OLE object will be represented by

the associated application icon in Creo Elements/Direct 2D Access.
Optionally, click Change Icon to select a different icon for the OLE object.

3. Specify a name for the OLE object in the User Input Line.
4. Specify the insertion position for the OLE object in Creo Elements/Direct 2D

Access.

The OLE object is displayed in the Creo Elements/Direct Drafting drawing.

Create From File
This option inserts the contents of a file as an object into your document so that
you can activate the object by means of the application in which it was created.
To create an OLE object from an existing file:

1. Click Browse. Select the file you want to link from the File Browser.
2. Click Open to open this file.
3. Optionally, switch on Link to link the OLE object to its source application such

that changes in the original file are reflected in the OLE object in Creo
Elements/Direct 2D Access.
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4. If you use the Display As Icon option, the OLE object will be represented by
the associated application icon in Creo Elements/Direct 2D Access.
Optionally, click Change Icon to select a different icon for the OLE object.

5. Click OK.
6. Specify a name for the OLE object in the User Input Line.
7. Specify the insertion position for the OLE object in Creo Elements/Direct 2D

Access.

The OLE object is displayed in the Creo Elements/Direct Drafting drawing.

Editing an OLE Object in Creo Elements/
Direct 2D Access
Once the OLE object is inserted in the drawing, you can edit it as described in the
following sections.

Deleting an OLE Object
To delete an OLE object from your drawing:

1. Pull down the Insert menu.
2. Click OLE and Delete.
3. Select the OLE object to be deleted.

Moving an OLE Object
To move an OLE object:

1. Pull down the Insert menu.
2. Click OLE, Edit and Move.
3. Specify a reference point.
4. Specify a destination point.
5. Select the OLE object to be moved.

Scaling an OLE Object
To scale an OLE object:

1. Pull down the Insert menu.
2. Click OLE, Edit and Scale.
3. Specify the center of scaling.
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4. Enter the scale factor for the X-direction.
5. Enter the scale factor for the Y-direction.
6. Select the OLE object to be scaled.

Arranging OLE Objects
To arrange OLE objects:

1. Pull down the Insert menu.
2. Click OLE, Edit and To Front or To Back.
3. Select the OLE object you want to move to the foreground or background.

Hiding and Showing OLE Objects
To improve system performance or to reduce screen clutter, OLE objects can be
hidden with the Show command. If the drawing includes several OLE objects, you
can choose to hide individual or all OLE objects. The Show options are:
On Unhides a hidden OLE object
Off Hides an OLE object
Box Hides an OLE object but places a reference frame around the

hidden image
Icon Displays an icon that represents the OLE object

Tip
When zooming with the dynamic mouse (CTRL + right
mouse button), hide the OLE objects with the Box option.

Activating an OLE Object
By activating an OLE object, you open the underlying file in its source application
for editing. OLE objects you created by means of the Create from File option will
reflect changes in the underlying file.
To activate an OLE object:

1. Pull down the Insert menu.
2. Click OLE and Activate.
3. Select the OLE object you want to activate.

Using the OLE Browser
To display the OLE Browser:
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1. Pull down the Insert menu.
2. Click OLE and then OLE Browser.
The OLE Browser displays information about the OLE objects currently included
in your drawing:
Name The name you specified for the OLE object
Z-level Numerical value for the "hidden" level assigned to an image in

the drawing
Show Status of the SHOW command; ON, OFF, or ICON
X-Scale Scaling factor in the x-direction
Y-Scale Scaling factor in the y-direction
OLE Type OLE object type
Program ID Application object type
Class ID OLE object class ID
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Creo Elements/Direct Annotation

Introduction...............................................................................................................80
Loading a Creo Elements/Direct Annotation Drawing ...................................................82
Using the Sheet Browser to Navigate among Sheets and Views....................................82
Views .......................................................................................................................83
Showing Differences in a View Following a 3D Change ................................................84
Changing Hidden Line and Tangent Line Colors and Linetypes .....................................84

This chapter discusses the Creo Elements/Direct 2D Access Annotation module
for use in Creo Elements/Direct 2D Access.
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Introduction
The Creo Elements/Direct Annotation module included in Creo Elements/Direct
2D Access enables you to visualize MI format 2D drawings generated by Creo
Elements/Direct Annotation.

General Procedure
The general Creo Elements/Direct 2D Access Annotation procedure comprises the
following steps:

• Prepare the Creo Elements/Direct 2D Access drawing environment for Creo
Elements/Direct Annotation.

• Load an MI file generated in Creo Elements/Direct Annotation.
• View this file as appropriate. For example, you can manipulate views and you

can hide or delete elements. Note that a warning message is displayed for any
"structurally dangerous" operations that would impair 3D/2D associativity.

• Following changes to the underlying 3D model in Creo Elements/Direct
Drafting, update the relevant view(s) to visualize and review the resulting
changes in 2D.

• Edit the 2D views as appropriate.
• Check the part structure of the Creo Elements/Direct Annotation MI file by

means of the Part Browser.

Creo Elements/Direct Annotation Rules
To ensure that the Creo Elements/Direct Annotation MI drawing file retains its
3D/2D associativity for further use in Creo Elements/Direct Annotation, you must
observe the following rules when using the Creo Elements/Direct 2D Access
Annotation module:

• Do not copy one drawing into another drawing.
• Do not manually insert one or more sheets into another drawing.
• Do not manually insert views into a sheet (using the view definition

commands of Annotation). Only use the Sheet commands provided by the
Creo Elements/Direct 2D Access Annotation module.

• Do not change or delete info texts beginning with "SD_" or "DOCU" or "AM_
".

• Only use the View commands provided by the Creo Elements/Direct 2D
Access Annotation module.
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• Do not scale view parts or 3D parts below view parts with the command in the
Parts menu of Creo Elements/Direct 2D Access. Only use the Scale command
provided by the Creo Elements/Direct 2D Access Annotation module.

Limitations
Some operations performed in the Creo Elements/Direct 2D Access Annotation
module will not deliver the expected results after reloading and updating in Creo
Elements/Direct Annotation.

• Parts created in Drafting as sub-parts of the TOP part named "SD_drawing"
will not be loaded into Creo Elements/Direct Annotation.

• Geometry or any other additional elements created in the TOP part named
"SD_drawing" will not be loaded into Creo Elements/Direct Annotation.

• Subparts created in Drafting (and which are not owned by the TOP part) will
not be displayed in the Drawing Browser of Creo Elements/Direct Annotation.
However, their geometry is displayed in the viewport.

• Leader lines (or text with leaderlines) created in Drafting will not behave
associatively in Creo Elements/Direct Annotation.

• Hatch holes automatically created in Drafting (forced by dimensions or texts
when Drafting option TEXT_HOLE_INSERTION is set to ON by default) do
not update associatively in Creo Elements/Direct Annotation.

• Hatch holes automatically created in Creo Elements/Direct Annotation for text
do not update associatively in Drafting when the text is changed in Drafting.

• Hatches that were automatically created in Creo Elements/Direct Annotation
but deleted in Drafting will re-appear after the next update in Creo Elements/
Direct Annotation.

• 2D view parts created in Creo Elements/Direct Annotation that are renamed in
Drafting get their original name during the next update in Creo Elements/
Direct Annotation.

• If you split or merge 2D geometry in Drafting which was derived from the 3D
geometry during an update in Creo Elements/Direct Annotation, the geometry
will look like the original one after the next update in Creo Elements/Direct
Annotation.

Preparing the Creo Elements/Direct 2D Access
Drawing Environment
Before you load an MI file generated in Creo Elements/Direct 2D Access
Annotation, be sure to complete the following steps:
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1. To make sure that the top part is empty, enter the following into the user input
line:
RESET_SYSTEM
CONFIRM

2. Creo Elements/Direct Annotation does not update the preview data in the Creo
Elements/Direct Annotation MI file loaded in Creo Elements/Direct 2D
Access. Therefore, switch off the Preview mode by entering the following in
the Creo Elements/Direct 2D Access user input line:
PRE_VIEW
OFF

3. Activate the Creo Elements/Direct 2D Access Annotation module by clicking
Modules, Annotation.

Loading a Creo Elements/Direct
Annotation Drawing
When you have prepared the Creo Elements/Direct 2D Access drawing
environment as discussed in Preparing the Creo Elements/Direct 2D Access
Drawing Environment on page 81, proceed as follows to load an MI file generated
in Creo Elements/Direct Annotation.

1. In Annotation, click Drawing ▶▶ Open.
2. Select the MI file you want to load from the Open Annotation file browser.

Using the Sheet Browser to Navigate
among Sheets and Views
The Sheet Browser enables you to quickly and easily select a sheet or a view
included in a sheet.

Displaying the Sheet Browser
To display the Sheet Browser:

1. In Annotation, click Drawing ▶▶ Sheet ▶▶ Sheet Browser.
2. Drag the Sheet Browser to where you want to display it.

Selecting a Sheet or View from the Sheet Browser
To select a sheet from the Sheet Browser:

1. In the Sheet Browser, click Curr Sheet.
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2. Click on the associated sheet number in the right-hand column of the Sheet
Browser.

To select a view from the Sheet Browser:

1. In the Sheet Browser, select the sheet in which this view is included.
2. Click Curr View.
3. Click on the associated view number in the right-hand column of the Sheet

Browser.

Views
The Annotation module provides a number of commands for selecting and
changing views.

Selecting the Current View
In addition to the method described in Selecting a Sheet or View from the Sheet
Browser on page 82, you can proceed as follows to select the current view in the
current sheet:

1. In Annotation, click Drawing ▶▶ View ▶▶ Current View.
2. Click on the view you want to make current.

Hiding Hidden Lines
To hide hidden lines in the Creo Elements/Direct Annotation MI file:

1. In Annotation, click Hide ▶▶ Hidden Line.
2. Select the view(s) in which you want to hide hidden lines.

Hiding Tangent Lines
To hide tangent lines in the Creo Elements/Direct Annotation MI file:

1. In Annotation, click Hide ▶▶ Tangent Line.
2. Select the view(s) in which you want to hide tangent lines.

Showing Hidden Lines
To show (previously hidden) hidden lines in the Creo Elements/Direct Annotation
MI file:

1. In Annotation, click Show ▶▶ Hidden Line.
2. Select the view(s) in which you want to show hidden lines.

Creo Elements/Direct Annotation 83



Showing Tangent Lines
To show (previously hidden) tangent lines in the Creo Elements/Direct Annotation
MI file:

1. In Annotation, click Show ▶▶ Tangent Line.
2. Select the view(s) in which you want to show tangent lines.

Showing Differences in a View Following
a 3D Change
Any view you see in the Creo Elements/Direct 2D Access Annotation module is a
2D derivative of a 3D model view in Drafting. When the underlying 3D model
changes in Drafting, you can update the associated view in Creo Elements/Direct
2D Access Annotation and check for differences in the view before and after this
update.

Showing Differences
In Annotation, click Show Difference.

• By default, the Creo Elements/Direct Annotation update colors are used to
mark differences as well as unchanged elements.

• Any unchanged elements are marked by the equal info text flag.
• Any changed elements are marked by the non-equal info text flag.

Hiding Differences
To hide the differences in a view before and after the update of the underlying 3D
model, click Reset Show. Note that Reset Show returns the view to the state prior
to Show Difference.

Changing Hidden Line and Tangent Line
Colors and Linetypes
In the Annotation module, you can change the color and linetype of hidden lines
and tangent lines.

1. In Annotation, click Change.
2. Select the change you want to perform:

Hidden Line to change the color and/or linetype of hidden lines.
Tangent Line to change the color and/or linetype of tangent lines.
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This chapter shows you how to print and plot drawings and how to produce screen
dumps.
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Using the Print Manager
In a Windows environment, Creo Elements/Direct 2D Access spools all plots and
screendumps either to the Print Manager or to the Clipboard, and not directly to an
output device.
The Print Manager controls device selection, configuration, and spooling for the
printers and plotters on your system. Once you send a plot from Creo Elements/
Direct 2D Access to the Print Manager, the Print Manager takes over the process
of producing the final output. By setting REQUEST_PRINT_SETUP, you can
directly access the Print Manager's setup dialogs each time you plot or
screendump.
The Clipboard temporarily stores a plot or screendump so that it can be
electronically transferred or "pasted" into another application.

Note
Depending on the output device(s) on your system, the Print Manager may
allow you to set several printer/plotter options in addition to those offered by
Creo Elements/Direct 2D Access. Refer to your Windows documentation and
hardware manuals for information on configuring your printer/plotter to work
with Windows.

Creating a Print Configuration
To facilitate the creation of consistent print/plot output, Creo Elements/Direct 2D
Access enables you to create any number of print configurations.
To create a print configuration:

1. Pull down the File menu and click Print. Alternatively, click the following
button in the Creo Elements/Direct 2D Access toolbar:

2. In the Print menu, select and/or specify the settings you want to save in the
new print configuration. These settings are discussed in the following sections
of this chapter.

3. In the Print configuration section of the Print menu, click Settings.
4. At the top of the Print Configurations dialog box, specify a name for the print

configuration you want to create.
5. Click Add to add this new print configuration name to the list of print

configurations.
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6. If you want to save the print configuration for future use, select it and click
Store.

7. In the Store Print Configurations dialog box, select or specify a name (such as
my_print.cfg) for your print configuration file. Note that this filename
does not have to be the same as the print configuration name. However, be
sure to specify a name that is readily identified.

8. Click Save to save this file.

Example of a Print Configuration
The following is an example of a Creo Elements/Direct Drafting or Creo
Elements/Direct 2D Access print configuration.

{ User specific customization }

WIN_PRT_MGR PAPER 'a3' ORIENTATION LANDSCAPE COPIES 1 END
PLOT_SCALE AUTO
PLOTTER_TYPE ADD MSWINDOW_GDI_PRINTER PRT_DRIVER 'HP LaserJet
1100' 'department_1' END

WIN_PRT_MGR PAPER 'a4' ORIENTATION PORTRAIT COPIES 1 END
PLOT_SCALE AUTO
PLOTTER_TYPE ADD MSWINDOW_GDI_PRINTER PRT_DRIVER 'HP DeskJet'
'department_2' END

WIN_PRT_MGR PAPER 'a4' ORIENTATION LANDSCAPE COPIES 1 END
PLOT_SCALE AUTO
PLOTTER_TYPE ADD MSWINDOW_GDI_PRINTER PRT_DRIVER 'HP LaserJet
1100' 'department_3' END

PLOTTER_TYPE 'department_3'

{ plot it }
PLOT 0,0 0 all BW_IMG NORM_VIDEO

The settings in this customize_p.m print configuration file imply the
following:

• One copy of the drawing is printed to A4 paper in landscape orientation.
• The drawing is scaled to fit.
• The PLOTTER_TYPE variable is set to department_3. This is the printer

that will be used as the output device.
• The entire drawing is printed in normal (as opposed to inverse) video.
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Re-Using a Saved Print Configuration
When you quit Creo Elements/Direct 2D Access, the system automatically saves
your current print settings. This will be the setting used when you start Creo
Elements/Direct 2D Access again.
You can see and modify your current configuration file by opening
<application data path>\PTC\Creo Elements Direct Drafting
[version]\[version]\print_configurations\current_print_
cfg.m

You can also use existing or create your own configuration files. If you use the
name convention (print_cfg_<configuration name>.m) for your own
configuration files and place them in the print_configurations
subdirectory then these files appear in the Print menu as a print configuration.
Configurations that you create with the Print dialog are automatically stored in
this subdirectory when you store your configuration.
To re-use binary legacy print configuration files with file name <print
configuration>.cfg from a CoCreate Drafting version < 13.00:

1. Click File ▶▶ Print from the main menu.
2. In the Printmenu, Click Settings. The Print Configurations dialog box appears.
3. In the Print Configurations dialog box, Click Load. The Load Print

Configurations dialog box appears.
4. In the Load Print Configurations dialog box, select the print configuration file

(such as test.cfg) you want to load.
5. Click Open. The respective print configuration name appears in the Name

selection list of Print Configurations dialog box.
6. Select the print configuration from the Name selection list.
7. Click Close to close the Print Configurations dialog box.

The Print menu settings change to the settings contained in the newly loaded
print configuration.

Defining the Print/Plot Settings
Before printing or plotting a drawing, you should define exactly what will be
printed/plotted and how the drawing will be printed/plotted.
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Setting the Plot/Print Destination
Creo Elements/Direct 2D Access can send plots and screendumps either to the
Windows Print Manager or to the Clipboard. You usually send plots to the Print
Manager for output on the system's default printer or plotter. Send a plot to the
Clipboard if you want to insert it into another Windows application. You can also
define the output destination of a file by clicking Browse from the Print menu.

Note
Creo Elements/Direct 2D Access automatically derives the extension for the
output file according to the selected printer/plotter.

Selecting a Printer or Plotter
To set a printer or plotter:

1. Pull down the Name selection list in the Printer section of the Print menu.
2. Select the printer or plotter from this list.
3. Click Properties to set the properties (such as the paper size and the

resolution) of this printer or plotter.
If the printer or plotter you want to use is not included in this list, use standard
Microsoft Windows techniques to install, set up and configure this printer or
plotter.

Note
Refer to your Windows documentation and hardware manuals for information
on configuring your printer/plotter to work with Windows.

Routing the Print/Plot Output to a File
If you want to send the print/plot output to a file, click on the Print to file check
box.
Be sure to select the printer or plotter in whose format you want to create this
output file. For example:

• If you want to create an HP-GL file, be sure to select an HP-GL compatible
plotter.

• Alternatively, if you want to create a PostScript file, be sure to select a
PostScript printer.
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When you click OK to start the print/plot job, you are prompted for a filename.

Setting the Paper Size and Number of Copies
Select the applicable paper size from the Size selection list in the Paper section of
the Print menu.
If you have a multi-sheet drawing, click Use sheet format to automatically set the
format and orientation of each sheet based on the sheet size.
To set the number of copies, either click the up or down arrow in the spin box to
change the number, or enter the number in the Copies field.

Setting Orientation
To set the print/plot orientation, click the Portrait or Landscape radio button.

Note
If you set the paper size such that the height and width are equal, the
orientation is set to landscape by default.

Positioning Your Drawing
The two Position options are:

• Center

• Left

Centering the Drawing
This is the default option.
To center your drawing on the page, click the Center radio button.
To center the drawing, Creo Elements/Direct 2D Access places an unseen box
around all outermost dimension text, drawing lines, or text. This box is then
centered on the paper.

Left Justifying the Drawing
To position your drawing at the lower left corner prior to printing/plotting, click
the Left radio button.
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Creo Elements/Direct 2D Access will place an unseen box around the outermost
dimension text, drawing lines, or text. This box is then placed in the lower left
corner of the paper.

Specifying Linear Offsets
For both Center and Left, you can specify an offset in the X direction and in the Y
direction. The print/plot output will be moved accordingly in the X direction and/
or Y direction.
Note that these offsets are interpreted in terms of the current length unit (such as
mm) set up for your Creo Elements/Direct 2D Access environment.

Setting a Rotation Angle
If you want to rotate the drawing output to the printer/plotter, enter the angle in
the Rotate field in the Position section of the Print menu.
The angle of rotation is interpreted in terms of the current angular units set up for
your Creo Elements/Direct 2D Access environment.

Selecting the Drawing Range for Printing/Plotting
You can print/plot the complete drawing, the current viewport, or a boxed area.
The three Range options are:

• All

• Viewport

• Box

All the Drawing
Click the All radio button in the Range section of the Print menu to print/plot the
entire drawing — irrespective of the current viewport contents. This is the default
option.

The Current Viewport
Click the Viewport radio button in the Range section of the Print menu to print/plot
the contents of the current viewport.
For example, if you are currently viewing a part, only the elements of that part
contained within the window of the current viewport will be printed/plotted.
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A Boxed Area
Click the Box radio button in the Range section of the Print menu to print/plot a
specific area of a viewport only. Creo Elements/Direct 2D Access prompts you to
specify the two opposite corners of a box. The contents of the boxed area will be
printed/plotted irrespective of what is displayed on the screen.
For example, suppose you are currently viewing a part, and other parts/elements
exist in the same area but are not displayed. If you click Box, all drawing elements
existing in the boxed area, both displayed and not displayed, will be plotted.

Setting the Plot Scale
This section shows how to set the scale to be used for the subsequent print/plot
output.
You can set a scale factor or automatically scale the drawing as large as possible
within the limits of your paper.

Entering a Scale Factor
This is the default option. The entire print/plot output will be scaled, but
dimension values are not affected.
Figure 9. Operation of Print/Plot Scale on page 92 shows the operation of print/
plot scale.

Figure 9. Operation of Print/Plot Scale

To set the print/plot scale factor:

1. Click the Factor radio button in the Scale section of the Print menu.
2. Enter the required scaling factor.
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If you set the plotting scale such that the drawing is too large for the paper, Creo
Elements/Direct 2D Access will warn you at the start of a plot by displaying the
maximum scale possible. Pressing ESC will abort the plot and allow you to reset
the plot scale. Otherwise, press the space bar and the plot will continue, cutting off
elements outside the paper format.

Fitting a Drawing
Click the Fit radio button in the Scale section of the Print menu. The print/plot
output of your drawing will be scaled as large as possible within the limits of the
paper size you specified.

Setting the Content of the Print/Plot Output
Creo Elements/Direct 2D Access enables you to specify what will be included in
the print/plot output:

• Drawing

• Current Show

Content: Drawing
Click the Drawing radio button in the Content section of the Print menu to print/
plot the drawing using standard drawing conventions. Drawing lines, dimensions,
text and hatching will be included in the print/plot output. Construction lines,
spotlights for parts and so on are omitted.
The drawing will appear as a normal drawing irrespective of the screen status (that
is, the plot is unaffected by the Show functions).

Content: Current Show Attributes
Any combination of drawing lines, dimensions, hatching, text, or layers can be
printed/plotted.

1. Select a viewport in which you want to set up your own drawing conventions.
2. Use the Show functions to set up the desired attributes.
3. Click the Current Show radio button in the Content section of the Print menu to

print/plot to print/plot what is currently shown in the drawing.
The subsequent plots will contain whatever drawing conventions you have
selected in the current viewport.
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Note
Drawing and Current Show only determine how the plot will appear. The
plotting area is unaffected.

Colors
This section of the Print menu enables you to set the True Color option and to set
up a Plot Transformation map for your printer/plotter environment.

True Color
Switch on the True Color check box option to create a color plot of your drawing
that is suitable for output to color output devices capable of producing color
rastering.
This feature is available on PostScript Level 2 printers and HP-GL/2 printers. This
means, for example, if you have access to an HP DesignJet 650C color printer you
can print any number of colors up to the capability of the printer.

Note
If you have a drawing that contains elements in white, and specify truecolor
plotting, the elements are drawn in white. Normally, when sending drawings to
a pen-plotter, the white elements on the screen are converted to black

Plot Transformation
The Plot Transformation map enables you to map the colors and pensizes of
elements in your drawing for output to a printer or plotter.
Proceed as follows to set up the Plot Transformation map:

1. Click Plot Transformation in the Colors section of the Print menu
2. In the Plot Transformation map, click the row you want to change. This row

will be highlighted.
3. Click Edit to display the Pen Format dialog box.
4. In the Pen Format dialog box:

• Select a "from" linetype and then a "to" linetype to which you want to map
the "from" linetype. For example, if you want all dashed lines in the
drawing to be plotted as dotted lines, map "from" dashed "to" dotted.
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If you want to map all linetypes in the drawing to the associated linetypes
on the plotter, click All Linetypes.

• Select a "from" color and then a "to" color to which you want to map the
"from" color. For example, if you want all cyan lines in the drawing to be
plotted in a custom pen color, select Cyan from the Color selection list and
then select Custom from the To selection list to define that custom color.

If you want to map all colors in the drawing to the associated colors on the
plotter, click All Colors.

• Select a "from" pensize and then a "to" pensize to which you want to map
the "from" pensize. For example, if you want pensize 0.3 in the drawing to
be plotted by a 0.45 pen on the plotter, enter 0.3 in the Pen Size field and
0.45 in the To field.

If you want to map all pensizes in the drawing to the associated pensizes
on the plotter, click All Pen Sizes.

Assigning a Specific Pen to a Given Linetype/Color
Combination
In the Plot Transformation map, proceed as follows to assign a specific plotter pen
to a given linetype/color combination:

1. Select the color from the Color selection list.
2. Select the linetype from the Linetype selection list.
3. In the Plotted As section, select the linetype to be plotted. If you want to plot

the same linetype that is used in the drawing, select Same Linetype.
4. Use the spin box to select the associated pen number.
5. Specify a pen width.
6. Click OK to add the changed row to the Plot Transformation map.
For example, let us assume that you want to use a 0.3 mm blue pen to plot all
dashed blue lines of the drawing. This pen is pen # 5 in your plotter.

1. Select the dashed linteype and the color blue in the Drawing section of the Plot
Transformation map.

2. In the Plotted As section, click Same Linetype.
3. Specify a pen width of 0.3.
4. In the Pen spin box, set the pen number to 5.
Repeat this procedure until the Plot Transformation map contains the required map
of colors, linetypes, and associated plotter pens.
To restore the Plot Transformation default settings, click Reset.
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Setting the Pixmap Color
When printing or plotting a drawing that includes embedded pixmaps, you can set
the output of the image to be either Black & White or Color.

Retaining or Inverting Black and White Pixmaps
The Reverse radio button in the B&W Pixmap section of the Print menu enables
you to reverse black and white pixmaps in the print/plot output.

Setting the Linetype Length
You can set the pattern length for any of the seven broken linetypes. Each broken
linetype is a pattern repeated many times to produce a line. Via the Plot Linetype
Length map, you can specify the length of each pattern and thus alter the fineness
of the line. Figure 10. Different Linetype Lengths on page 96 shows two DASH_
CENTER lines drawn with different linetype lengths. The linetype length is
shown arrowed.

Figure 10. Different Linetype Lengths

The seven broken linetypes that you can set are:

• DASHED
• LONG_DASHED
• DOT_CENTER
• DASH_CENTER
• PHANTOM
• CENTER_DASH_DASH
• DOTTED
To set the linetype length and minimum space for individual broken linetypes:
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1. Click Pattern Length at the bottom of the Print menu to dispay the Plot
Linetype Length map.

2. In the Length field, specify a segment length for each broken linetype.
3. In the Min. Dist. field, specify the minimum distance (the gap) between the

broken line segments.
Alternatively, if you want to set all broken linetypes to the same segment length
and the same minimum distance, click All Linetypes. Then specify a single length
and a single minimum distance.

Previewing a Print/Plot
Open the Plot Preview system viewport to see print/plot output on your screen.
You can open the viewport after you select all the necessary print settings (as a
last step before printing), or open it to watch while working on your drawing.

1. Click File.
2. Click Print.
3. Click Show Preview.
4. Select a color setting for the Plot Preview viewport only.

• Original: to preview color printer/plotter output.
• Grayscale: to preview black and white printer/plotter with dithering

capability output.
• BW: to preview black and white printer/plotter output.

5. The Plot Preview viewport appears or is updated.
The Plot Preview viewport remains open until you uncheck it in the Print dialog
box.

Starting a Print or Plot Job
When you have selected or specified all of the required print/plot output settings,
click OK at the bottom of the Print menu to send your drawing to either the Print
Manager or to the Clipboard or to a file.
The Print Manager queues the drawing to the current default output device. The
Clipboard temporarily stores the drawing so that it can be electronically pasted
into another application.

Printing or Plotting Multiple Drawing Files
To plot or print multiple Creo Elements/Direct Drafting drawing files from the
File Browser:

Printing and Plotting 97



1. In the Windows file browser, select the drawing file(s) to be printed or plotted.
2. Press the right mouse button on this selection.
3. Click Print.

Dumping the Creo Elements/Direct 2D
Access Screen
To copy the entire Creo Elements/Direct 2D Access screen to the Clipboard, press
[Alt] & [Print].
Then paste the screendump into a graphics application of your choice for further
processing.
For example, in Microsoft® Paint, pull down the Edit menu and click Paste to
paste the Creo Elements/Direct Drafting screendump to the drawing area.

Writing a Creo Elements/Direct 2D Access
Screendump to an Output File
Optionally, you can write a screendump of the current Creo Elements/Direct 2D
Access window directly to an output file.

1. Click File
2. Click Export
3. Follow Bitmap to File across and choose an option:

• BMP
• JPEG
• PNG
• TIFF

4. You will be prompted through the rest of the export.
Prompts are:
Enter PORT, BOX, DEL_OLD or "destination" - to select input

• Enter point, CURRENT or viewport number - to further select after
PORT

• Enter lower left and upper right corner of box which is to
be dumped - to select after BOX

Enter RESOLUTION or "destination"

• Enter PAPER_TO_PIXELS or output image width, height - if
you select RESOLUTION
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○ PAPER_TO_PIXELS - recalculates paper format and dpi to your X,Y
resolution. You will be prompted for a paper format (A-E, A4-A0) or size,
and then you will be prompted for dpi.

○ Enter output image width, height - enter width and height in
pixels. Enter -1 for either width or height to retain the ratio of the current
viewport and specify the other dimension in pixels.

Possible error messages are:

• Not enough memory available to perform the operation.
• ***The output image size is limited to a maximum of 4/3 billion pixels.

Further Information
For further technical information about plotting or dumping, refer to the Creo
Elements/Direct 2D Access help system:
Enter help plot or help bitmap_to_file at the Creo Elements/Direct 2D
Access command line.
The screen will clear and Creo Elements/Direct 2D Access will display further
information about plotting or dumping.
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Customizing the Creo Elements/
Direct 2D Access User Interface

Displaying and Hiding Menus ................................................................................... 101
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Resetting the Layout................................................................................................ 109

Creo Elements/Direct 2D Access provides a rich set of tools and options for user
interface customization. Any customization changes in Creo Elements/Direct 2D
Access are written to macros.
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Displaying and Hiding Menus
To display or hide menus in the Creo Elements/Direct 2D Access user interface:

1. Press the right mouse button on any menu item.
2. Check the applicable checkbox to display a menu or set of menus.

Alternatively, uncheck any items you want to hide.

Editing Toolbar Items
To change the name, type, action or other property of a menu item in the Creo
Elements/Direct 2D Access user interface:

1. Display the menu item you want to change.
2. Press the right mouse button on that menu item. This brings up the Edit

Toolbar Item dialog box.
Caption Key The string in this field is the label displayed for the

current menu item.
Enabled Tick this box to enable the menu item or untick this

box to gray out the menu item.
Unique Name The Creo Elements/Direct 2D Access internal name

for this menu item. Note that this name must be
unique.

Item Type This combo box enables you to pull down a selection
list of standard Microsoft Windows item types. The
item types in this list are context sensitive. For
example, a popup button enables you to select a
submenu (discussed below) which will be displayable
via this popup button.

Submenu Enables you to branch to a submenu.
ToolTip Key A brief description of the current menu item.
On Action A command or function or macro name (e.g.: change_

color) to be triggered via this menu item. Note that
any macro specified here must be created separately.

On Right Click Command, function or macro name to be triggered by
pressing the right mouse key on this menu item.

Category This string allocates the menu item to a category for
selection in the Toolbar Items tab.

Domain Name of the file where Creo Elements/Direct 2D
Access will look for your localized version (if any) of
this menu item. Note that multiple toolbars may share
the same domain file. Optionally, a separate domain
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file may be created for each toolbar.
Image Brings up an icon editor. Refer to Creating Icons on

page 106 for details.
List Keys Click New (Insert) to add an entry to the list of items.

Click Delete to remove an item from this list. Click the
Up or Down arrow to scroll within the list of keys.
Note that any action string you define here requires an
associated action definition in a separate macro.

Note
Combo boxes, radio buttons and checkboxes require the creation of a separate
macro. For more detailed background information on the user interface
customization capabilities of Creo Elements/Direct 2D Access, refer to the
TOOLBAR_ITEM section in the Creo Elements/Direct 2D Access Help.

Destroy not only removes items from the Toolbar Items tab but actually
deletes the associated files. Note that Destroy cannot be undone.

Creating Custom Menus
To create a custom menu:

1. Pull down the Tools menu, click Customize and Customize Layout.
Alternatively, press the right mouse button on any existing menu item and
click Customize Layout.

2. In the Customize dialog box, click Add.
3. In the Add Toolbar dialog box, specify the following:

Caption Key The string in this field is the label displayed for the
current menu item.

Locked Locks the menu so it cannot be destroyed.
Unique Name The Creo Elements/Direct 2D Access internal name for

this menu item. Note that this name must be unique.
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On Right Click Command, function or macro name to be triggered by
pressing the right mouse key on this menu item.

Domain Name of the message file (if any) where Creo
Elements/Direct 2D Access will look for your localized
version (if any) of this menu item. Each toolbar and
toolbar item in the Creo Elements/Direct 2D Access
user interface is associated with a specific "domain"
file. This domain file contains all of the strings
associated with your toolbar or toolbar items. These
strings include:
• Caption
• Category
• Tooltip
• List Items
In the domain file, you can edit (e.g. localize) these
strings.

4. Click OK.
5. Drag and drop the menu to any location in the Creo Elements/Direct 2D

Access user interface

Example: Creating a Background Menu
This example illustrates the procedure for creating a cascaded menu that enables
you to change the background color of the current viewport in Creo Elements/
Direct 2D Access. The newly created Background menu will contain a submenu
with two buttons:

• Black
• White
The first task is to create two empty toolbars. The first of these will receive a
popup button that displays the second toolbar. The second toolbar will then
receive two "action" buttons that change the background color.

Stage 1: Defining Two Empty Toolbars
To define the first (initially empty) toolbar:

1. Click Tools ▶▶ Customize ▶▶ Customize Layout ▶▶ Add.
2. Specify the following in the Add Toolbar dialog box:

Caption Key Background
Unique Name tlb_backg
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On Right Click Retain the default.
Domain cust_menus

3. Click OK to return to the Customize dialog box.
To define the second (initially empty) toolbar:

1. Click Tools ▶▶ Customize ▶▶ Customize Layout ▶▶ Add.
2. Specify the following in the Add Toolbar dialog box:

Caption Key Background_2
Unique Name tlb_backg_2
On Right Click Retain the default.
Domain cust_menus

3. Click OK to return to the Customize dialog box.
Result of this exercise:
You have just created two empty toolbars. Both of these are named Background.

Stage 2: Creating a Cascaded Submenu
Next, you will make one of these toolbars a "cascaded submenu" of the other:

1. In Customize, click on the Toolbar Items tab.
2. Click Add to dispay Add Toolbar Item.
3. In Add Toolbar Item, select or specify the following:

Caption Key Black or White
Item Type Popup Button
Unique Name pob_black_white
Submenu tlb_backg_2

.

4. Retain the defaults for the remaining fields.
5. Click OK.
6. Drag the newly created pob_black_white item to the Background menu

you created in Stage 1.
Result of this exercise:

You have just created a first menu label in the toolbar named named Background.
The black arrow pointing to the right suggests cascading.
You can now click on the Black or White label to display the (still empty)
toolbar you just defined as its submenu.
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Stage 3: Adding Two Action Buttons to the Cascaded
Submenu
Next, you need to define the two menu items for this newly created submenu.
To create the Black menu button:

1. In Toolbar Items, click Add.
2. Select or specify the following in the Add Toolbar Item dialog box:

Caption Key Black
Unique Name btn_background_black
Item Type Push Button
ToolTip Key Changes the background color to black
On Action change_viewport_color black end

3. Retain the defaults for the remaining fields.
4. Click OK.
To create the White menu button:

1. In Toolbar Items, click Add.
2. To define the White menu button, select or specify the following in the Add

Toolbar Item dialog box:
Caption Key White
Unique Name btn_background_white
Item Type Push Button
ToolTip Key Changes the background color to white
On Action change_viewport_color white end

3. Retain the defaults for the remaining fields.
4. Click OK.
Next, you need to drag these two buttons to the cascaded submenu:

1. Drag the Black pushbutton definition from Toolbar Items to the cascaded
submenu.

2. Drag the White pushbutton definition from Toolbar Items to the cascaded
submenu.

Stage 4: Test
To test your new cascaded menu:

1. Drag the Background menu to any position in the Creo Elements/Direct 2D
Access user interface.
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2. Click on the Black or White menu label.
3. Click White to change the viewport background color to white.
4. Click Black to change the viewport background color to black.

Creating Icons
To create an icon:

1. In the Edit Toolbar Item dialog box, click Edit under Image to bring up the
Image Editor.

2. Use the Image Editor drawing tools to draw the geometry of your icon. Select
colors as appropriate.

3. When you have completed the geometry, pull down the Image Editor File
menu and click Save.

4. Specify a filename for the new image.
5. Click Save to save the file.

Adding Icons to the Toolbar
To add an icon (as a button) to the Creo Elements/Direct 2D Access toolbar:

1. Pull down the Tools menu, click Customize and Customize Layout.
2. In the Toolbar Items tab, select the item for which you want to add or change

an icon.
3. Click Edit to bring up the Image Editor.
4. Create the icon.
5. Click OK to return to the Edit Toolbar dialog box. Check whether or not the

icon meets your requirements.
6. Click Edit to edit the icon or click OK to accept the icon.
7. The menu item now has the icon associated with it. Drag and drop the menu

item (complete with its icon) to the menu where you want to use it.

Defining Key Commands
To define a custom key command:

1. Pull down the Setup menu and click Keys.
2. In the Key Definitions dialog box, click a key (such as [1]).
3. Specify any or all of the following commands:
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Plain Enter the command to be executed when the key is
pressed.

Control Enter the command to be executed when the key is
pressed in combination with the [Ctrl] key.

Alt Enter the command to be executed when the key is
pressed in combination with the [Alt] key.

Alt-Control Enter the command to be executed when the key is
pressed in combination with the [Alt]+[Ctrl] keys.

4. Check the Execute box if you want the command to execute when the
associated key (or key combination) is pressed.

If you leave this box unchecked, the command will simply be written to the
User Input Line in Creo Elements/Direct 2D Access when you press the key
(or key combination). To execute the command, press [Enter].

Note
Note that some keys (such as F1) are disabled because they serve a predefined
function in the Windows environment.

Displaying Menus and Dialog Boxes via
Mouse Buttons
You can allocate any Creo Elements/Direct 2D Access menu or dialog box to a
mouse button so the menu or dialog box pops up when that mouse button is
pressed. The allocation procedure uses the following syntax:

define_mouse_key <key number> <mode> "show_popup_menu '<action
text>'"#M

where:
define_mouse_
key

is the macro command that allocates a command to a mouse
button.

key number is either 1 (left mouse button), 2 (middle mouse button), or 3
(right mouse button).

mode is one of the following:
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plain: The command is to be executed when the mouse button
is pressed. Note that you should not use plain combined with
the left mouse button because this button is used for menu
selection and drawing work in Creo Elements/Direct 2D
Access.
shift: The command is to be executed when the mouse button
is pressed in combination with the [Shift] key.
alt: The command is to be executed when the mouse button is
pressed in combination with the [Alt] key.
shift alt: The command is to be executed when the mouse
button is pressed in combination with the [Shift]+[Alt] keys.

show_popup_
menu

is the macro command that brings up the menu or dialog box
specified through the command

action text is the name of an Creo Elements/Direct 2D Access menu or
dialog box. Note that this string is case sensitive.

#M causes the command to be executed immediately when the
mouse button is pressed. If you decide to leave out #m, the
command will be written to the command line.

For example, to display the Arc menu by pressing the right mouse button
combined with the [Shift] key, enter the following command string into the User
Input Line:

define_mouse_key 3 plain "show_popup_menu 'Arc'"#M

Note
The Creo Elements/Direct 2D Access menu names are case sensitive.

Displaying Dialog Boxes Directly
The Creo Elements/Direct 2D Access dialog boxes can be displayed directly.
Simply enter the associated WUI command string in the User Input Line. To find
out these command strings, enter:

LIST_KEYWORDS SCREEN

into the User Input Line. The resulting Creo Elements/Direct 2D Access keyword
list is displayed in a separate text editor window. Scroll to the section of keywords
beginning with WUI_ to see the keywords that will display dialog boxes.
For example, to display the Construction menu, enter:
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WUI_CONSTRUCTION

Managing Layouts
Via Tools, Customize, Creo Elements/Direct 2D Access provides the following
layout management options:
Save Layout Saves the entire layout to a file.
Save Toolbars Saves one or multiple user-selected toolbars to a file.
Load Layout Loads an entire layout.
Load Toolbars Loads one or multiple user-selected toolbars.

Converting Existing Multi-Column Menus
The mcm2lcassic.m macro supplied with this release of Creo Elements/Direct
2D Access enables you to convert multi-column menus created with earlier Creo
Elements/Direct Drafting or Creo Elements/Direct 2D Access releases.

Resetting the Layout
To return your Creo Elements/Direct 2D Access layout to its original
(uncustomized) state, simply click Tools ▶▶ Customize ▶▶ Reset Layout.
If you have inadvertently removed the Reset Layout button or if you have lost the
Customize submenu or the entire Tools menu, enter the following command in the
user input line to restore the original Creo Elements/Direct 2D Access layout:

toolbar_layout reset confirm
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14
Unicode

Introduction
Creo Elements/Direct Drafting’s different internal and external encoding schemes
were Unicode incorporated for version 2007. Unicode allows text and symbols
from all languages to be consistently represented and manipulated by computers.
All textual and string data processed by Creo Elements/Direct Drafting is held
internally in Unicode (UTF-8) encoding. That means most of Drafting's
functionality processes user input from almost any language, and string data from
different languages can be mixed. For example, it is now possible to have
German, Japanese, and Russian characters within a single string, such as a part
name.
Drafting's font list contains all the Creo Elements/Direct true type fonts that are
dynamically converted to internal font format when referenced. An appropriate
font that contains all desired characters must be selected to display texts and
dimension texts correctly. Fonts containing characters from the whole Unicode
range are relatively rare, and they usually contain the word Unicode in their name
(for example, Arial Unicode MS).
Symbols are a special Creo Elements/Direct Drafting feature and display with hp_
symbols and hp_symbols2 fonts. They can still be composed in old-style escape
sequences (#15#XY#16) but for compatibility with Unicode are mapped to a
private-use Unicode area [E000-E1FF]:

• 15#XY#16 — 0xE000 + XY
• 30#XY#31 — 0xE100 + XY

MI file format
Version 3.20 MI files are encoded in Unicode (UTF-8). Files stored to older MI
versions are encoded as before, depending on the current locale. When loading
older MI formats, the Creo Elements/Direct Drafting loader uses the information
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recorded in the info section (~1) of the MI file. MI formats without encoding
information in their info sections are treated as if encoded in ROMAN8 or SJIS
(Japanese locale).

Macro file encoding
Old macro files did not contain any encoding information. They were assumed to
be encoded for current locales (e.g. ROMAN8 for English and SJIS for Japanese
locales). However, this causes problems when using the same macros in different
locales.
Version 2007 supports macro Unicode but maintains backward compatibility.
We recommend you change old macro files such that their encoding is explicitly
specified with the DEFINE_ENCODING directive.
Text macro files containing Unicode UTF-8 or UTF-16 BOMs (Byte Order
Markers), supported by most popular Windows text editors, are read as Unicode.
Files containing the DEFINE_ENCODING directive are always read in the
specified encoding. Otherwise they are treated as old macro files and encodings
are locale dependent:

• SJIS for Japanese
• BIG5 for traditional Chinese
• GB2312 for simplified Chinese
• ROMAN8 for all else

Limitations
The displaying of Unicode texts is limited. Features such as combining characters,
Arabic cursive connection, and bidirectional algorithm are not fully implemented.
CHR, NUM and # still work in old locale-dependent internal encodings
(ROMAN8 & SJIS). They return different results in different locales. They are
obsolete; their use is only for maintaining backward compatibility. For example,
((CHR 154)+(CHR 223)) or its equivalent (#154#223) displays a Japanese
character with Unicode code 22756 (hex 58E4) on a Japanese locale and two
Latin characters on other locales. To avoid problems and to display the same
character regardless of locale, use Unicode versions of these functions: (UCHR
22756), (UCHR '58E4'), #u22756, or #ux58E4.
Combinations of # and CHR to compose 2-byte characters and symbols are not
allowed. For example, ((CHR 154)+#223) does not work.
Strings that begin with (CHR 255) are icons and are not encoded in UTF-8. Pre-
2007 CoCreate Drafting versions let you compose icons using a large variety of
combinations (for example #255'abc'#212+CHR 12). In version 2007, only CHRs
can be used to compose icons.
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MI files of versions prior to 2.90 that do not contain encoding information in their
info section (~1) load correctly only if loaded in the same locale as they were
drawn. For example, you have 2 options to correctly load a Japanese MI file of
version 2.80 in English Creo Elements/Direct Drafting:
1. Load the file in japanese locale and store it back in new format:

a. CHANGE_LOCALE 'ja'
b. LOAD 'japanese.mi'
c. STORE MI ALL DEL_OLD 'japanese.mi'
d. CHANGE_LOCALE 'en'

2. Load the MI file in a text editor and manually add section ~1 at the beginning
of MI file:
a. #~1
b. ENCODING:SJIS
c. Such files load correctly in any locale.

AIl modules call internal Creo Elements/Direct Drafting functions and use strings
in internal encoding. Before CoCreate Drafting 15.00 (2007) these strings were
encoded in ROMAN8 or SJIS, depending on locale. Compatibility is maintained
only for characters in range [0, 127]. If AI modules use characters in a different
range, they must be changed and recompiled to support UTF-8.

File names encoding
In CoCreate Drafting 2007, file names display in the same fashion as other
Windows applications. Prior to 2007 they were shown in the internal encoding,
which was different and dependant on locale. Files names were consequently
shown differently if extended characters were used.
You can set the MEEXTFN option in the .ini file to zero to keep the old
behavior.

Changed font concept
CoCreate Drafting 2007 does not distinguish between 1-byte and 2-byte fonts (in
terms of default settings or text properties). Because Creo Elements/Direct
Drafting now has Unicode support, there is just one current font at a time and each
text and dimension text has just one assigned font.
CoCreate Drafting 2007 includes new default fonts which have been combined
from the old 1- and 2-byte definitions:

• osd_default combines hp_i3098_v and hp_kanj2_c
• osd_default2 combines hp_i3098_c and hp_kanj2_c
• osd_default3 combines hp_d17_v and hp_kanj2_c
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When loading old 2D files with texts or dimension texts using characters from 1-
and 2-byte fonts (fonts that are not already included in any of the osd_default
fonts), Creo Elements/Direct Drafting automatically combines the 2 fonts into a
single font containing the character definitions from both fonts. It names them "1-
byte=font name"#"1-byte=font name".
You can combine those fonts (1- and 2-byte fonts) into a single font using a new
command MERGE_TWO_FONTS.
TrueType fonts converted to Creo Elements/Direct Drafting fonts contain all
defined characters. Separate symbol fonts are used.
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This tutorial provides you with a "step-by-step" guided tour of most of the Creo
Elements/Direct 2D Access functionality. The example drawing file used in this
tutorial is supplied with Creo Elements/Direct 2D Access.

Note
In some of the following illustrations the dimensions have been switched off.
This is to make the illustrations clearer. It is not necessary for you to switch
off the dimensions.

114 Inspection with Creo Elements/Direct 2D Access Windows User Interface



Loading the Drawing
Proceed as follows to load the drawing file provided for this tutorial in Creo
Elements/Direct 2D Access:

1. Start Creo Elements/Direct 2D Access.
2. Pull down the File menu and click Load File.
3. Select example.mi from the File Browser and then click OK to load this

drawing file.

The drawing will now load into viewport 1 as shown below.

Creating Viewports
To prepare for the exercises presented in this tutorial, create three viewports
similar to the ones shown in the following figure. Proceed as follows:

1. Pull down the Setup menu.
2. Click Viewport and then Create.
3. Click two diagonally opposite corner points for viewport 2. This new viewport

should occupy the top left quarter of the Creo Elements/Direct 2D Access
drawing area.

4. Use the same procedure to create viewport 3. This new viewport should
occupy the top right quarter of the Creo Elements/Direct 2D Access drawing
area.

5. Click Fit to fit the entire drawing into viewport 3.
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Note that the last viewport you created is the current (active) viewport.

Placing Detail Areas in the Viewports
Place a view of the right part of the drawing into viewport 1. To do this:

1. Pull down the Setup menu, click Viewport and Current.
2. Click on the 1 in the top right corner of viewport 1 to make this viewport the

current viewport.
3. Click New (either in the View menu or on the right-hand menu bar).
4. Box the area (A) as shown below by picking the bottom left-hand corner and

the top right-hand corner in viewport 1. Creo Elements/Direct 2D Access
displays the boxed area in viewport 1.
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Now place a detail in each of the other two viewports:

1. Click on the 3 in the top right corner of viewport 3 to make this viewport the
current viewport.

2. Click New and box the detail area (B) in viewport 3. Press CTRL and the left
mouse button to pan. Press CTRL and the right mouse button to zoom.

Creo Elements/Direct 2D Access displays the boxed area in viewport 3.
3. Make viewport 2 the active viewport.
4. Click New and box the second detail area (C) as shown below.

Creo Elements/Direct 2D Access displays the boxed area in viewport 2.
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All three viewports will now contain a view as shown below.

Measuring a Detail
Creo Elements/Direct 2D Access has a measuring facility which lets you
accurately determine geometrical values from your drawing. The groups
MEASURE and CATCH combine to form a powerful tool in the determination of
geometrical values.
This part of the tutorial shows you how to measure basic drawing features.
In the drawing, a dimension has been accidently left out. The detail for this
missing dimension is in the top right-hand viewport 3. To measure the length:

1. Pull down the Tools menu, click Measure and Length.
2. Pick line D as indicated in the following figure. Creo Elements/Direct 2D

Access displays the length value in the User Prompt Line at the bottom of the
screen.

3. Press ENTER to continue.
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Now you need to find out the horizontal distance from the edge E to the detail
edge F. This is shown in the viewports 2, and 3. To do this:

1. Pull down the Tools menu, click Measure and Distance.
2. Enter the qualifier HORIZONTAL into the User Input Line.
3. Pick the two points E and F as shown above. Creo Elements/Direct 2D Access

displays the distance in the User Prompt Line.
4. Press ENTER to continue.

Using the Show options
Technical drawings often include large amounts of dimensioning, hatching, and
text which can obscure some details. This part of the tutorial shows how you can
selectively display what is in each of the viewports.
For this part of the tutorial you need to place a new detail area in two of the
viewports. Do the following:

1. Make viewport 3 current and click Fit.
2. Make viewport 1 current, click New and box the area (G) in viewport 1.
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3. Make viewport 2 current, click New and box the area (H) in viewport 2.

You can use the Show commands to display or hide entire classes of elements
in a viewport. For example, you may want to view a drawing without its text.
To do this:

4. Pull down the Setup menu and click Show.
5. In the Show dialog box, switch off Text.
6. Click Redraw in the View menu to see the geometry clearly.

Plotting a Drawing
You are now ready to print or plot your drawing. The print/plot options define
how your drawing will be printed or plotted.

1. Pull down the File menu and click Print.
2. In the Print dialog box, select the appropriate printer (or plotter) and paper

format.
3. Press the Center radio button in the Position section to place the drawing in the

middle of the page to be printed or plotted.
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4. Press the Fit radio button in the Scale section to scale the drawing to be as
large as possible within the limits of the paper.

5. Optionally, save this print/plot configuration in a configuration file.
6. Click OK to print or plot your drawing.

Tutorial Complete
You have now finished the tutorial. If you want to, you can practice some further
Creo Elements/Direct 2D Access operations using the example. You might want to
try some commands and operations on your own drawings.
When you have finished with the tutorial example, click Delete, All and Confirm to
delete the drawing from all viewports.
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Creo Elements/Direct 2D Access can be customized to suit your individual
requirements.
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Note
You need to be fully conversant with Creo Elements/Direct 2D Access before
you start customizing Creo Elements/Direct 2D Access.

When Creo Elements/Direct 2D Access is started up, it reads and executes a
number of files which define a variety of functions such as the screen menus and
Creo Elements/Direct 2D Access environment. These files are executable
programs called macros which you can edit and store under your own filenames to
be reloaded and used as required. It is therefore possible to create your own
alternative definitions for the screen menus and Creo Elements/Direct 2D Access
environment. This process is known as customizing.
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Customizing the Creo Elements/Direct 2D
Access Environment
The Creo Elements/Direct 2D Access environment consists of such things as the
the size and color of text, the plot scale, the drawing scale, and units.
All these are controlled by the settings of the environment functions, of which
there are more than 70 in the system. An example of an environment function is
DIM_COLOR. This can be set to produce dimensions with any of the colors
available.
The current settings of the environment functions can be stored in a file. Here is a
listing of part of an Creo Elements/Direct 2D Access environment file:

MAX_FEEDBACK 100
CONFIGURE_EDITOR '$' 1 79
UNITS 1 MM
UNITS 1 DEG
CS_REF_PT 0,0
CS_AXIS 1,0 0,1
FOLLOW OFF
GRID_FACTOR 10
CURRENT_FONT 'hp_block_v'
TEXT_FRAME OFF
TEXT_ANGLE 0
TEXT_ADJUST 1
TEXT_LINESPACE 2.2
TEXT_FILL OFF
TEXT_SIZE 1
TEXT_RATIO 1
TEXT_SLANT 0
LINE WHITE SOLID END
C_LINE RED DOTTED END
TEXT WHITE END

At startup, the functions are set as shown in the listing to provide a standard
environment. During normal use, the settings are changed from the screen menu.
It is also possible to change the function settings by editing the Creo Elements/
Direct 2D Access environment. This method is useful because it gives an
overview of the status of all environment functions at once. It also gives access to
those functions that are inaccessible from the screen menus.
A customized environment can be stored in a named file. This file can then be
used to restore the same environment whenever it is required.
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Changing the Creo Elements/Direct 2D Access
Environment
To display the environment file:

1. Enter edit_environment.
The environment will be displayed and the function settings can be changed as
required. When you have finished changing the environment, save the file and exit
the text editor to implement all the changes to Creo Elements/Direct 2D Access.
The current environment can be stored for future use in a named file as follows:

1. Enter save_environment.
2. Enter 'env_filename'. (The name of your own choice.)
To execute the stored file and redefine the system environment:

1. Enter INPUT 'env_filename'.

Converting Binary Files to ASCII files
All the macros that correspond to each block are in the file hp_macro_s. We do
not recommend that you change any of the macros in this file. However, you can
copy the file under a different name, and then edit the copy.
The hp_macro_s file is a binary file. Before you can do any editing, you must
create an ASCII copy of the file. Here's how to do it:

1. Enter the command:
DELETE_MACRO ALL

All macros within the workstation's memory will be deleted.
2. Load the macros within the binary file by entering the command:

LOAD_MACRO 'sys_filename'

sys_filename is the name of the system file, in this case hp_macro_s.
3. Store the macros as an ASCII file on disk by entering the command:

SAVE_MACRO ALL 'newfile'

newfile is a name of your choice. We recommend that this name be
different from the system filename.

4. To restore all the macros that were previously deleted from the system, enter
the command:
INPUT 'startup'

You can now edit the file newfile that you created previously. To load the
macros in this file, input the file. This will overwrite any macros of the same name
that were loaded during startup.
There are two ways to ensure that your macro is loaded at startup:
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• Keep the macro in a separate file. If this file is called newfile, then include
the following line in a file called customize:
INPUT 'newfile'

• Copy the altered macro to the file called customize. This file can be used to
overwrite any of the system macros that you want to alter.

With both of these methods, you must remove the braces from the following line
in the startup file:
{INPUT 'customize'}

Now the customize file will be input at startup. Any macros in this file will be
loaded. Any INPUT statements will be executed, so macros in other files can also
be loaded.

Writing Macros
A macro is a series of commands, executed sequentially, which are stored in a file.
You can write macros to minimize the amount of time you spend on commonly
used command sequences. You can use macros for activating commands that are
not on the screen menu.
To create a macro enter EDIT_FILE and your filename, using 'single' or "double"
quotation marks. If the file does not already exist, Creo Elements/Direct 2D
Access creates a new one, the screen clears with the text cursor at the top of the
screen. Type in your macro and save it.

The Structure of a Macro
The first line of a macro is mandatory and defines the name of the macro. The
macroname does not have to be the name of the file in which you store the macro,
it is possible to have any number of macros within the same file. For example, the
system file /Drafting [version]/hp_macro_s contains several macros
that Creo Elements/Direct 2D Access uses.
The first line of a macro looks like this:

• DEFINE macroname
Instructions about choosing a suitable macroname are in the HELP file under the
keyword NAME.
Now you can define your macro. It can consist of:

• Creo Elements/Direct 2D Access commands.
• Macro operators, the help file describes these operators.
• Other macros.
An example of a macro could be:

DEFINE deload
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DELETE ALL CONFIRM
LOAD
END_DEFINE

This macro deletes the current part and then prompts for the name of another
drawing file that you want to load.
The last line (END_DEFINE) is also mandatory and marks the end of the macro.

Loading a Macro
You use the LOAD MACRO command to load a macro onto the system. The
macro must have been stored using the STORE_MACRO command. To use this
command:

1. Enter LOAD_MACRO.
2. Enter the name of the macro you want to load.
Creo Elements/Direct 2D Access loads the macro. To execute the macro, enter the
macroname.

Editing a Macro
You can use the EDIT_MACRO command to:

• Edit, or list an existing macro.
• Create a macro by entering a new macroname.
To use this command:

1. Enter EDIT_MACRO.
2. Enter the name of the macro you want to edit, list, or create. If you enter a new

macroname, Creo Elements/Direct 2D Access creates a new macro.
Creo Elements/Direct 2D Access displays the macro. If you have entered a new
macroname then the screen will be blank as the macro is empty.

Inputting a Macro
Use the INPUT command to load a macro from an ASCII file. Once a macro is
active, you can execute the macro by entering the macroname. For example, the
example macro will be executed whenever deload is entered.

Executing and Running Macros
You now have a file that contains one or more macros. If you want to use any of
these macros you can either enter INPUT filename or enter LOAD_MACRO.
After this, you can execute the macro by typing in the appropriate macroname.
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Customizing the Keyboard
When working with Creo Elements/Direct 2D Access, you may carry out some
operations more frequently than others. This section describes how you can
customize the keyboard to reduce the time you spend on these operations.
At the top of your keyboard there are normally eight function keys labeled [f1] to
[f8] that you can customize.
For example, you may set several directories as current during an Creo Elements/
Direct 2D Access session. To save time, you can customize the function keys to
set each directory as current. Once you have done this, you only need to press this
key, then press ENTER and the named directory will be set to current.
Any command can be implemented in this way and eight examples are given in
this section.
You use the DEFINE_KEY command to customize the function keys.
The syntax for this command is described below.
DEFINE_KEY key_number 'command_name'

The key_number defines which function key you are customizing (1 to 8).
The command_name is the command name.

Example
The following example describes how to customize the eight function keys:

1. Enter EDIT_FILE. The system will prompt for a filename.
2. Enter "customize".

Unless you have previously stored some customized files or macros in the file,
the screen will now go blank (because the file is empty at the moment). Type
in your first command line. An example could be:

• DEFINE_KEY 1 "CURRENT_DIRECTORY 'c:/users/alan/proj1'"

In the above line, 1 is the defined function key and CURRENT_DIRECTORY
'c:/users/alan/proj1' is the text to be displayed in the User Input
Line.

You can define the other function keys in exactly the same way. An example
of all eight defined keys is shown below.

DEFINE_KEY 1 "CURRENT_DIRECTORY 'c:/users/alan/proj1'"
DEFINE_KEY 2 "CURRENT_DIRECTORY 'd:/users/larry/proj2'"
DEFINE_KEY 3 "CURRENT_DIRECTORY 'd:/users/mary/proj3'"
DEFINE_KEY 4 "CURRENT_DIRECTORY 'k:/users/geoff/proj4'"
DEFINE_KEY 5 "CURRENT_DIRECTORY 'i:/users/steve/proj5'"
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DEFINE_KEY 6 "CHANGE_VIEWPORT_SIZE"
DEFINE_KEY 7 "CHANGE_VIEWPORT_COLOR"
DEFINE_KEY 8 "EDIT_PART POINT"

The first five function keys set the named directories as current. Function keys
6 and 7 are used for altering the viewports. Function key 8 is used, in a
drawing that contains parts, to make a picked part active.

3. After entering the command lines, press CTRL+D to store your changes in the
file.

4. Input the file customize by entering INPUT customize.

The function keys will be defined and ready for your use.

Loading and Listing Text Fonts
A text font is a group of pre-defined geometrical patterns that can be placed on a
drawing. Each pattern in a font is made up of straight lines joining points on a
grid, and is associated with a keyboard character so that it can be easily called.
Although normally used for text (the standard system annotation and
dimensioning texts are produced this way), text fonts can also produce special
symbols. Because there can be many points in the grid, highly detailed symbols
can be defined.
If you need special text or symbols, you can create them with your own
customized text fonts and store them on disk ready for use. A good example of
text font use is for producing company trademarks, logos, etc.
Text fonts are very versatile - these are some of the main features:

• Characters can be filled or unfilled
• The character width-to-height ratio can be set
• The character slant angle can be set (forwards or backwards)
• The line angle can be set (0 to 360 degrees)

The System Fonts
When the system is started up, a number of font files are loaded into memory.
However, only one of them is the current font and available for immediate use.
Creo Elements/Direct Drafting’s different internal and external encoding schemes
were Unicode on page 110 incorporated for version 2007.
You can find out which fonts are in memory by entering LIST_FONTS. If no new
fonts have been defined since system startup, the display will become as follows,
and then you can return to the menu using ESC.

Fonts loaded:
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osd_default2
osd_default3
osd_default
hp_def_font

Font used:
osd_default

Current font:
osd_default

This table gives the names of fonts that are in memory and has nothing to do with
the files from which they are created. The fonts hp_Y14.5 and hp_i3098_v are
loaded from files with the same names, but hp_def_font is created within the
system and displays a box on the screen to represent the space that will be
occupied by characters before they are drawn.
There are files available on the disk that create fonts when they are loaded. The
complete list is:

osd_default Default Creo Elements/Direct Drafting font containing hp_
i3098_v and hp_kanji2_c characters with variable character
spacing

osd_default2 Default Creo Elements/Direct Drafting font containing hp_
i3098_c and hp_kanji2_c with fixed characters spacing

osd_default3 Default Creo Elements/Direct Drafting font containing hp_
d17_v and hp_kanji2_c with variable characters spacing

hp_Y14.5 Used for symbols only
hp_i3098_v ISO 3098 font with variable character spacing
hp_i3098_c ISO 3098 font with constant character spacing
hp_block_v Filled font with variable character spacing
hp_block_c Filled font with constant character spacing
hp_d17_v DIN17 font with variable character spacing
hp_d17_c DIN17 font with constant character spacing
hp_jasc_v Kanji Japanese and Greek font with variable character spacing
hp_jasc_c Kanji Japanese and Greek font with constant character spacing
hp_symbols Special characters for dimensioning: °, ±, minutes, seconds

To increase the speed of access, all the files listed above are stored as binary files
on the disk and cannot be input. They have to be loaded using:
LOAD_FONT 'bin_filename'
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bin_filename is the name of the binary file. It is possible for a binary file to
contain more than one font, in which case they will all be loaded. Each of the
system files contains only one font that has the same name as the filename. The
LOAD_FONT command will not change the current font.

Customizing the Startup File

Note
To edit the Creo Elements/Direct 2D Access startup file, you need to be
logged in as root. Your system administrator knows the root password for
your workstation.

If you exit Creo Elements/Direct 2D Access, any customized features that you
have entered, although stored in files, are not defined when you start Creo
Elements/Direct 2D Access. To redefine the customization, the files containing the
customization must be input again.
If you want your customization automatically defined whenever you start Creo
Elements/Direct 2D Access, you should edit the Creo Elements/Direct 2D Access
startup file. The startup file contains the commands that load the system
files when you start Creo Elements/Direct 2D Access. To edit the startup file
do the following:

1. Enter:

• EDIT_FILE 'startup' and press ENTER.

A listing of the startup file will be displayed on the screen. The listing of the
file is shown below.

INPUT 'passwords'
LOAD_MODULE 'VIEW'
LOAD_FONT 'hp_i3098_v'
LOAD_FONT 'hp_Y14.5'
LOAD_FONT 'hp_symbols'
CURRENT_FONT 'hp_i3098_v'
LET Menu_slot_border_distance_y 0
LET Fill_up_menu 0
LET Menu_position LOWER
LOAD_MACRO 'hp_macro'
INPUT 'defaults'
Configure_system
LOAD_MACRO Sys_macro_filename
LOAD_MACRO Sys_tmacro_filename
LOAD_MACRO Sys_menu_filename
INPUT Sys_tmenu_filename
{Enable_data_management}
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{Enable_dm_classification}
{Enable_dm_bom}
Startup_menus
{INPUT 'customize'}

2. Remove the braces {} from around {INPUT 'customize'} so that it reads:

• INPUT 'customize'
3. Press CTRL+D to store your changes.
Check that all your files containing customized features are in the file called
customize. If they are not, INPUT the filenames as described below.
For example, if you had two customized files: Custm_fk, and Sm_menu_1 you
would include the following lines at the end of the customize file:

• INPUT 'Custm_fk'
• INPUT 'Sm_menu_1'
During startup, the startup file automatically loads customize which in turn
will load the customized files: Custm_fk and Sm_menu_1.

Creo Elements/Direct 2D Access
Command and Function Names
The command or function name tells the system which operation to carry out.
Each command or function has a unique name. The names for all of the Creo
Elements/Direct 2D Access commands, functions, and macros are listed below.
Some commands require Qualifiers, for example SCREEN. Qualifiers provide
additional information about the specific operation that is to be carried out. Some
commands precede others. For example, to use the LIST ITEMS command you
first have to enter CATALOG.
Commands differ slightly from functions. Commands immediately terminate any
previous command (or function). Function, however, can interrupt a command (or
another function) without terminating it. Once a function has been executed,
control is automatically returned to the previously unfinished command (or
function) in which you were working.
General Commands/Functions
Command/Function Option Name
HELP MEVIEW_HELP
DELETE plus qualifiers DELETE
DELETE confirm MEVIEW_DEL_ALL

Filing Commands/Functions
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Command/Function Option Name
LOAD drawing/part MEVIEW_LOAD
CATALG current dir. MEVIEW_CATALOG
CATALOG named directory CATALOG `Name'
SET DIR MEVIEW_SET_DIR
LOAD plus qualifiers LOAD
LIST ITEMS (CATALOG first) DETAIL_INFO
SELECT (CATALOG first) SELECT
SORT UP (CATALOG first) SORT
SORT DOWN (CATALOG first) REVERSE_SORT
CATALOG ITEMS filenames "FILE_NAME

physical name "PHYS_SIZE
file description "FILE_DESC"
file type "FILE_TYPE"
file size "FILE_SIZE"
create date "CREATE_DATE"
modify date "MODIFY_DATE"
access date "ACCESS_DATE"
numerical access "NUM_ACCESS"

CURRENT
DIRECTORY

CURRENT_DIRECTORY

COPY FILE COPY_FILE
EDIT FILE EDIT_FILE

Setting Up Commands/Functions

Command/Function Name
EDIT ENVIRONMENT EDIT_ENVIRONMENT
SAVE ENVIRONMENT SAVE_ENVIRONMENT
LOAD FONT LOAD_FONT
LIST FONTS LIST_FONTS
CURRENT FONT CURRENT_FONT
LIST MACRO NAMES LIST_MACRO_NAMES
LIST GLOBAL INFO LIST_GLOBAL_INFO
DRAWING SCALE DRAWING_SCALE

Hidden Line Commands/Functions
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Command/Function Option Name
HIDD DRAW on HL_REDRAW_MODE On
NORM DRAW off HL_REDRAW_MODE Off
INQ Z-VAL HL_INQ_Z_VALUE
GEN HIDDEN Hl_generation
SHOW ON on HL_SHOW_HIDDEN On
SHOW OFF off HL_SHOW_HIDDEN Off

SHOW Commands/Functions
Command/Function Option Name
ALL on SHOW_ALL_ON

off SHOW_ALL_OFF
DIMENSION on DIMENSION_ON

off DIMENSION_OFF
HATCH on SHOW_HATCH_ON

off SHOW_HATCH_OFF
TEXT on SHOW_TEXT_ON

off SHOW_TEXT_OFF
CONSTRUCTION on C_GEO_ON

off C_GEO_OFF
GEOMETRY on SHOW GLOBAL GEO ALL ON

off SHOW GLOBAL GEO ALL OFF
LAYER on I_SHOW_LAYER_ON

off I_SHOW_LAYER_OFF
SPLIT on SHOW VERTEX ON

off SHOW VERTEX OFF
INFO on I_SHOW_INFO_ON

off I_SHOW_INFO_OFF

WINDOW Commands/Functions
Command/
Functions

Option Name

FIT WINDOW_FIT
PAN norm WINDOW_PAN

dynam WINDOW_PAN_DYNAMIC
NEW norm WINDOW_NEW

dynam WINDOW_NEW_DYNAMIC
LAST WINDOW_LAST
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Command/
Functions

Option Name

REDRAW WINDOW_REDRAW
ZOOM norm WINDOW_ZOOM

dynam WINDOW_ZOOM_DYNAMIC
LRG/SM VIEWPORT_SWITCH
STORE STORE_WINDOW
RECALL WINDOW_RECALL
CENTER norm WINDOW_CENTER

dynam WINDOW_CENTER_DYNAMIC
DISPL LIST on WINDOW_DISPLAY_LIST On

off WINDOW_DISPLAY_LIST Off

VIEWPORT Commands/Functions
Command/Function Name
CREATE CREATE_VIEWPORT
DELETE DELETE_VIEWPORT
DELETE ALL DELETE_VIEWPORTALL
REDRAW NEW_SCREEN
CHANGE VIEWPORT SIZE CHANGE_VIEWPORT_SIZE
CHANGE VIEWPORT COLOR CHANGE_VIEWPORT_COLOR
CURRENT VIEWPORT CURRENT_VIEWPORT

PARTS Commands/Functions
Command/
Function

Option Name

EDIT part EDIT_PART
top EDIT_PART TOP
parent EDIT_PART PARENT

SHOW part SHOW_PART
all SHOW_PARTALL
part boxed SHOW_PART PART_BOX

SPOTLIGHT on SPOTLIGHT ON
off SPOTLIGHT OFF

VIEW part VIEW
top VIEW TOP
parent VIEW PARENT

PART LIST Count Screen PARTS_LIST TREE SCREEN
Tree Screen PARTS_LIST SCREEN
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MEASURE Commands/Functions
Command/Function Option Name
DISTANCE straight MEASURE_DISTANCE

horizontal MEASURE_DISTANCE
HORIZONTAL

vertical MEASURE_DISTANCE
VERTICAL

LENGTH MEASURE_LENGTH
ANGLE MEASURE_ANGLE
RADIUS MEASURE_RADIUS
POINT MEASURE_COORDINATE
AREA MEASURE_AREA
AREA PROPERTY AREA_PROPERTY
GET PROPERTY GET_PROPERTY

CATCH Commands/Functions
Command/
Function

Option Name

ALL on CATCH ALL
off CATCH OFF

INTERS CATCH INTERSECTION
permanent CATCH PERMANENT

INTERSECTION
CENTER CATCH CENTER

permanent CATCH PERMANENT CENTER
VERTEX CATCH VERTEX

permanent CATCH PERMANENT VERTEX
RULER/GRID CATCH GRID

permanent CATCH PERMANENT GRID
ELEMENT CATCH ELEM

permanent CATCH PERMANENT ELEM
RANGE CATCH RANGE

RULER or GRID Commands/Functions
Command/Function Option Name
RULER on RULER ON
DOT GRID on DOT_GRID ON
LINE GRID on LINE_GRID ON
OFF I_RULER_GRID_OFF
SPACING GRID_FACTOR

136 Inspection with Creo Elements/Direct 2D Access Windows User Interface



Command/Function Option Name
ORIGIN ORIGIN ON
PLACE absolute CS_SETABSOLUTE

relative CS_SET RELATIVE
MOVE CS_REF_PT
RESET I_RULER_GRID_RESET
ISOMETRIC top CS_AXIS ABSOLUTE 30 1 150 1

front CS_AXIS ABSOLUTE 150 1 90 1
side CS_AXIS ABSOLUTE 30 1 90 1

CURSOR large CURSOR LARGE
small CURSOR SMALL

TURN absolute CS_ROTATE ABSOLUTE
relative CS_ROTATE RELATIVE

PLOT Commands
Command Option Name
POSITION cent Set_sys_plot_center On

left Set_sys_plot_center Off
SCALE fit Set_sys_plot_plotscale 0

1 Plot_enter_plotscale_and_update
ROTATE ANG 0 Set_sys_plot_rot 0

90 Set_sys_plot_rot PI/2
SIZE A4 Set_sys_plot_format "A4"

A3 Set_sys_plot_format "A3"
A2 Set_sys_plot_format "A2"
A1 Set_sys_plot_format "A1"
A0 Set_sys_plot_format "A0"
A Set_sys_plot_format "A"
B Set_sys_plot_format "B"
C Set_sys_plot_format "C"
D Set_sys_plot_format "D"
E Set_sys_plot_format "E"

OUTPUT all Set_sys_plot_source All
viewport Set_sys_plot_source CURRENT

WINDOW'
CONTENTS drawing Set_sys_plot_as_displayed (FALSE)

as displayed Set_sys_plot_as_displayed (TRUE)
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Command Option Name
START PLOT View_plot_start
SCREENDUMP b & w Dump_screen_bw

color Dump_screen_color
PLOTTERTYP Plot_enter_plotter_type_and_update
PLOT
DESTINATION

Plot_enter_filename_prefix_and_update

Creo Elements/Direct 2D Access
Keywords
Keywords are reserved words within Creo Elements/Direct 2D Access used to
access relevant technical information from the help file.
Each keyword in the list is followed by an abbreviation indicating which type of
keyword it is. (Enter help list_keywords to display the list.)
There are four types of keywords:

• COMMANDS and FUNCTIONS (Cmd) or (Fnc): Command and function
keywords such as DOT_GRID and REDRAW will start their corresponding
action routine when typed by the user.

Keep in mind that functions can interrupt a command (or another function)
without terminating it. Once a function has been executed, control is
automatically returned to the previously unfinished command in which you
were working.

• QUALIFIERS (Qua): Qualifiers such as DEL_OLD and THREE_POINTS do
not have an action routine of their own. They are used by other commands and
functions to select one of the many options available to that command or
function.

• PSEUDO COMMANDS (Psc): Pseudo commands such as IF and END_
LOOP are only used internally. They control the execution of macros.

• ARITHMETIC FUNCTIONS (Afn): Arithmetic functions such as SIN and
SQRT are used within expressions. Their associated C function has to pick up
the necessary parameters and calculate the function result.

The following keywords are available:

ABS (Afn) ARCCOS
(Afn)
ABSOLUTE (Qua) ARCHIVE
(Cmd)
ADD (Qua) ARCS
(Qua)
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ADD_ATTRIBUTE (Cmd) ARCSIN
(Afn)
AFFINE (Qua) ARCTAN
(Afn)
ALL (Qua) ARC_RESOLUTION
(Fnc)
ALLBASE (Qua) AREA
(Qua)
AND (Afn) AREAS
(Qua)
ANG (Afn) AREA_PROPERTY
(Cmd)
ANG_BISECT (Qua) ARITHM_FUNCTION
(Qua)
APPEND (Qua) ARROW_TYPE
(Qua)

AS (Qua) CONNECT
(Cmd)
AS_DISPLAYED (Qua) CONNECT_TABLE
(Fnc)
ATTRIBUTE (Qua) CONTINUE
(Qua)
ATTRIBUTES (Qua) CONTROLZ_IS_EOF
(Fnc)
AUTO (Qua) CONVERT_TO_HP_SYMBOLS
(Fnc)
AUTO_NEW_SCREEN (Fnc) COPY
(Qua)
BACKGROUND_COLOR (Qua) COPY_FILE
(Fnc)
BACKUP (Cmd) COS
(Afn)
BALLOON (Qua) CREATE_DIRECTORY
(Fnc)
BEEP (Fnc) CREATE_ELEMENT
(Cmd)
BISECT (Qua) CREATE_LTAB
(Fnc)
BITMAP_TO_FILE (Fnc) CREATE_STORAGE_AREA
(Cmd)
BLACK (Fnc) CREATE_VIEWPORT
(Fnc)
BLUE (Fnc) CS_AXIS
(Fnc)
BORDER_COLOR (Qua) CS_MIRROR
(Fnc)
BOX (Qua) CS_REF_PT
(Fnc)
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BREAK (Qua) CS_ROTATE
(Fnc)
CANCEL (Cmd) CS_SET
(Fnc)
CATALOG (Fnc) CURRENT
(Qua)
CATALOG_LAYOUT (Cmd) CURRENT_DIM_TEXTS
(Fnc)
CATCH (Fnc) CURRENT_DIRECTORY
(Fnc)
CENTER (Qua) CURRENT_FONT
(Fnc)
CENTER_DASH_DASH (Fnc) CURRENT_MENU
(Fnc)
CEN_BEG_END (Qua) CURRENT_TMENU
(Fnc)
CEN_RAD_ANG (Qua) CURRENT_VIEWPORT
(Fnc)
CHANGE_TABLE_SIZE (Fnc) CURRENT_WINDOW
(Qua)
CHANGE_VIEWPORT_COLOR (Fnc) CURSOR
(Fnc)
CHANGE_VIEWPORT_SIZE (Fnc) CURSOR_COLOR
(Qua)
CHAR_LAYOUT (Cmd) CYAN
(Fnc)
CHECKIN (Cmd) C_CIRCLES
(Qua)
CHECKOUT (Cmd) C_COLOR
(Fnc)
CHECK_ERROR (Afn) C_GEO
(Qua)
CHECK_WINDOW (Fnc) C_LINES
(Qua)
CHILD (Qua) C_LINETYPE
(Fnc)
CHR (Afn) DASHED
(Fnc)
CIRCLES (Qua) DASH_CENTER
(Fnc)
CLASS (Qua) DATE
(Afn)
CLASSES (Qua) DB_LOAD
(Cmd)
CLEAR (Qua) DB_SET_DEFAULT
(Cmd)
CLOSE_FILE (Fnc) DEFAULT
(Qua)
CM (Qua) DEFAULT_TABLE
(Qua)
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COLOR (Fnc) DEFINE
(Fnc)
COLOR_LTAB (Fnc) DEFINE_CATALOG
(Fnc)
COLUMN (Qua) DEFINE_CLASS
(Cmd)
COLUMN_LAYOUT (Qua) DEFINE_FONT
(Fnc)
COMMAND (Qua) DEFINE_KEY
(Fnc)
CONFIGURE_EDITOR (Fnc) DEFINE_RELATION
(Cmd)
CONFIRM (Qua) DEG
(Qua)

DELETE (Cmd) END_PART
(Cmd)
DELETE_CLASS (Cmd) END_WHILE
(Psc)
DELETE_LTAB (Fnc) ENTER
(Fnc)
DELETE_LTAB_ROW (Fnc) ERROR_LOG
(Fnc)
DELETE_MACRO (Fnc) ERROR_STR
(Afn)
DELETE_MENU (Fnc) EXIT
(Cmd)
DELETE_TABLE (Cmd) EXIT_IF
(Psc)
DELETE_TMENU (Fnc) EXOR
(Afn)
DELETE_VIEWPORT (Fnc) EXP
(Afn)
DEL_OLD (Qua) FACES
(Qua)
DEL_VERSIONS (Qua) FALSE
(Afn)
DENSITY (Qua) FEEDBACK_INDICATOR
(Fnc)
DETAIL_INFO (Qua) FEET
(Qua)
DIAMETER (Qua) FILE
(Qua)
DIMENSIONS (Qua) FILES
(Qua)
DISCONNECT (Cmd) FILES_TO_ELEMENTS
(Qua)
DISPLAY (Fnc) FILLETS
(Qua)
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DISPLAY_LIST (Fnc) FIRST
(Qua)
DISPLAY_NO_WAIT (Fnc) FIT
(Qua)
DIST_ANG (Qua) FOLLOW
(Fnc)
DIST_DIST (Qua) FONT
(Qua)
DIV (Afn) FORCE
(Qua)
DMS_VERSION (Fnc) FORMAT
(Qua)
DOTTED (Fnc) FRACT
(Afn)
DOT_CENTER (Fnc) VIEW_WIDTH
(Qua)
DOT_GRID (Fnc) FUNCTION
(Qua)
DOT_TYPE (Qua) GEO
(Qua)
DOWN (Qua) GET_ELEM_INFO
(Fnc)
DRAWING_SCALE (Cmd) GET_PROPERTIES
(Fnc)
DUMP (Qua) GLOBAL
(Qua)
DUMP_SCREEN (Fnc) GRAPHIC
(Qua)
DUMP_SCREEN_DEFAULTS (Fnc) GRD
(Qua)
DYNAMIC (Qua) GREEN
(Fnc)
ECHO (Fnc) GRID
(Qua)
EDIT_ENVIRONMENT (Fnc) GRID_FACTOR
(Fnc)
EDIT_FILE (Fnc) GROUP
(Qua)
EDIT_MACRO (Fnc) HATCHING
(Qua)
EDIT_PART (Cmd) HEIGHT
(Qua)
EDIT_PORT (Fnc) HELP
(Fnc)
ELEM (Qua) HELP_PORT
(Fnc)
ELEMENTS (Qua) HIGHLIGHT_LTAB
(Fnc)
ELEMENTS_TO_FILES (Qua) HL_GENERATE_HIDDEN
(Cmd)
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ELSE (Psc) HL_INQ_FACE_COLOR
(Fnc)
ELSE_IF (Psc) HL_INQ_Z_VALUE
(Fnc)
END (Cmd) HL_REDRAW_MODE
(Fnc)
END_DEFINE (Psc) HL_SET_COLOR
(Fnc)
END_IF (Psc) HL_SET_LINETYPE
(Fnc)
END_LOOP (Psc) HL_VISUALIZE
(Fnc)

HORIZONTAL (Qua) LIST_MACRO_NAMES
(Fnc)
HPGL (Qua) LIST_MENUS
(Fnc)
HPGL2 (Qua) LITERAL
(Qua)
HP_SQL (Qua) LN
(Afn)
HSL_COLOR (Fnc) LOAD
(Cmd)
IF (Psc) LOAD_FONT
(Cmd)
ILLEGAL (Qua) LOAD_MACRO
(Fnc)
IMAGE_FIT (Qua) LOAD_MODULE
(Cmd)
INCHES (Qua) LOCAL
(Psc)
INDEX (Qua) LONG_DASHED
(Fnc)
INFOS (Qua) LOOP
(Psc)
INPUT (Fnc) LOWER
(Qua)
INQ (Afn) LTAB_COLUMNS
(Afn)
INQ_DB (Fnc) LTAB_ROWS
(Afn)
INQ_ELEM (Fnc) LTAB_TITLES
(Afn)
INQ_ENV (Fnc) LWC
(Afn)
INQ_SELECTED_ELEM (Fnc) MACRO
(Qua)
INSERT_LTAB_ROW (Fnc) MACRO_STAT
(Fnc)
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INT (Afn) MAGENTA
(Fnc)
INTERSECTION (Qua) MAKE_QUERY_PAGE
(Cmd)
KEEP (Qua) MARK
(Qua)
KEEP_POINTS (Qua) MATCH
(Afn)
KEYWORD_STAT (Fnc) MAXIMUM
(Qua)
KM (Qua) MAX_FEEDBACK
(Fnc)
KNOB_BOX (Qua) MAX_RADIUS
(Qua)
KNOB_BOX_FACTOR (Fnc) MEASURE_ANGLE
(Fnc)
LARGE (Qua) MEASURE_AREA
(Fnc)
LAST (Qua) MEASURE_COORDINATE
(Fnc)
LAST_FEEDBACK (Qua) MEASURE_DISTANCE
(Fnc)
LAST_PROMPT (Qua) MEASURE_LENGTH
(Fnc)
LAST_QUERY_RESULTS (Fnc) MEASURE_RADIUS
(Fnc)
LAST_WINDOW (Fnc) MEMORY_STAT
(Fnc)
LAST_WINDOWS (Qua) MENU
(Fnc)
LEADER_ARROW (Fnc) MENU_BUFFER
(Fnc)
LEADER_LINE (Cmd) MENU_LAYOUT
(Fnc)
LEADER_LINES (Qua) METERS
(Qua)
LEFT (Qua) MI
(Qua)
LEN (Afn) MILES
(Qua)
LET (Fnc) MILS
(Qua)
LG (Afn) MINIMUM
(Qua)
LINEPATTERN (Fnc) MIN_LENGTH
(Qua)
LINES (Qua) MIN_RADIUS
(Qua)
LINETYPE (Fnc) MIRR
(Afn)
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LINE_GRID (Fnc) MIRROR
(Qua)
LINKS (Qua) MIX
(Qua)
LIST_FONTS (Fnc) MM
(Qua)
LIST_GLOBAL_INFO (Fnc) MOD
(Afn)
LIST_KEYWORDS (Fnc) MODIFY_RELATIONSHIP
(Cmd)

MODIFY_USER (Cmd) PICK_VP_PNT
(Fnc)
MOVE (Qua) PLOT
(Cmd)
MOVE_ELEMENT (Cmd) PLOTTER_TYPE
(Fnc)
MOVE_TABLE (Fnc) PLOT_CENTER
(Fnc)
MULTIPLE (Qua) PLOT_DESTINATION
(Fnc)
NETUNAM (Fnc) PLOT_FORMAT
(Fnc)
NEW (Qua) PLOT_LINETYPE_LENGTH
(Fnc)
NEW_SCREEN (Fnc) PLOT_PEN_TABLE
(Fnc)
NEXT (Qua) PLOT_SCALE
(Fnc)
NONE (Qua) PLOT_TRANSFORMATION
(Fnc)
NORMAL (Qua) PLOT_VIEWPORT
(Fnc)
NOT (Afn) PNT
(Qua)
NO_DELAY (Qua) PNT3
(Qua)
NO_VIEWPORT_RANGE (Qua) PNT_MM
(Qua)
NULL (Qua) PNT_PIXEL
(Qua)
NUM (Afn) PNT_RA
(Afn)
NUMBER (Qua) PNT_XY
(Afn)
OF (Qua) PNT_XYZ
(Afn)
OFF (Qua) POINTS
(Qua)
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OLD_SQL_QUERY (Fnc) POLYGON
(Qua)
ON (Qua) POP_DOWN_LTAB
(Fnc)
ON_ERROR (Fnc) POP_UP_LTAB
(Fnc)
OPEN_INFILE (Fnc) PORT
(Qua)
OPEN_OUTFILE (Fnc) POS
(Afn)
OR (Afn) PREVIOUS
(Qua)
ORACLE (Qua) PRINT_TABLE
(Fnc)
ORIGIN (Fnc) PROMPT
(Qua)
OUTPUT_HP15 (Fnc) PROMPT_LINE
(Qua)
OUTPUT_HP16 (Fnc) PROMPT_LIST
(Fnc)
OWNER (Qua) PSEUDO_COMMAND
(Qua)
PAN (Qua) PT_ANG
(Qua)
PAN_SEL (Qua) PT_ANG_DIST
(Qua)
PARALLEL (Qua) PURGE_FILE
(Fnc)
PARAMETER (Psc) QUALIFIER
(Qua)
PARENT (Qua) QUERY
(Fnc)
PART (Qua) QUERY_ADD_CLASS
(Fnc)
PARTS (Qua) QUERY_ADD_COLUMN
(Fnc)
PARTS_LIST (Fnc) QUERY_ADD_SELECT
(Fnc)
PART_BOX (Qua) QUERY_ADD_SORT
(Fnc)
PASSWORD (Fnc) QUERY_AREAS
(Fnc)
PERF_MON_OFF (Fnc) QUERY_CLASSES
(Fnc)
PERF_MON_ON (Fnc) QUERY_COPY
(Fnc)
PERMANENT (Qua) QUERY_CREATE
(Fnc)
PERMISSIONS (Qua) QUERY_CREATE_CLASSIFICATION
(Fnc)
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PERPENDICULAR (Qua) QUERY_DELETE
(Cmd)
PER_RAD_ANG (Qua) QUERY_DELETE_CLASS
(Fnc)
PHANTOM (Fnc) QUERY_DELETE_COLUMN
(Fnc)
PI (Afn) QUERY_DELETE_SELECT
(Fnc)

QUERY_DELETE_SORT (Fnc) REPEAT
(Psc)
QUERY_DESTINATION (Fnc) RESERVE
(Qua)
QUERY_DIRECTION (Fnc) RESET
(Qua)
QUERY_EXECUTE (Fnc) RESTORE
(Cmd)
QUERY_FILES (Fnc) RETAIN_RASTER
(Fnc)
QUERY_FILE_NAME (Fnc) RETAIN_RELATIONSHIP
(Cmd)
QUERY_LEVELS (Fnc) REVERSE
(Qua)
QUERY_LIST (Fnc) REVERSE_SORT
(Qua)
QUERY_MODIFY_CLASS (Fnc) REVISION
(Qua)
QUERY_MODIFY_COLUMN (Fnc) REVISIONING
(Qua)
QUERY_MODIFY_SELECT (Fnc) RGB_COLOR
(Fnc)
QUERY_MODIFY_SORT (Fnc) RIGHT
(Qua)
QUERY_REFRESH (Fnc) RND
(Afn)
QUERY_RENAME (Fnc) ROT
(Afn)
QUERY_SAVE (Fnc) ROTATE
(Qua)
QUERY_SELECT_TABLE_NAME (Fnc) ROUND
(Afn)
QUERY_SET_SELECT (Fnc) ROW
(Qua)
QUERY_SORT_TABLE_NAME (Fnc) ROWS
(Qua)
QUERY_START_ELEMENT (Fnc) RPT
(Afn)
QUERY_TABLE_NAME (Fnc) RUBBER_ARC_BEG_END
(Qua)
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QUERY_TYPE (Fnc) RUBBER_ARC_CEN_BEG
(Qua)
QUERY_USER_TABLE_NAME (Fnc) RUBBER_ARC_CEN_END
(Qua)
RAD (Qua) RUBBER_BOX
(Qua)
RANGE (Qua) RUBBER_CIRCLE_2_PTS
(Qua)
READ (Fnc) RUBBER_CIRCLE_CEN
(Qua)
READ_FILE (Fnc) RUBBER_LINE
(Qua)
READ_LTAB (Afn) RUBBER_LINE_ANG
(Qua)
READ_ONLY (Qua) RUBBER_LINE_HORIZONTAL
(Qua)
RECALL_BUFFER (Fnc) RUBBER_LINE_VERTICAL
(Qua)
RECALL_WINDOW (Fnc) RULER
(Fnc)
RECALL_WINDOWS (Qua) RUN
(Fnc)
RECTANGLE (Qua) SAME
(Qua)
RECURSIVE (Qua) SAVE_ENVIRONMENT
(Fnc)
RECURSIVE_TO (Qua) SAVE_LTAB
(Fnc)
RED (Fnc) SAVE_MACRO
(Fnc)
REDRAW (Fnc) SAVE_MENU
(Fnc)
REF_PT (Qua) SAVE_TABLE
(Fnc)
RELATE (Cmd) SAVE_TMENU
(Fnc)
RELATED_CLASS (Qua) SAVE_VIEWPORT
(Fnc)
RELATED_CLASSES (Qua) SCALE
(Qua)
RELATIVE (Qua) SCREEN
(Qua)
RELEASABLE (Qua) SCREEN_TRANSFORMATION
(Fnc)
RELEASE (Cmd) SCROLL_BAR
(Qua)
REMOVE (Cmd) SCROLL_LTAB
(Fnc)
REMOVE_QUERY_PAGE (Cmd) SEARCH
(Cmd)
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REMOVE_USER (Cmd) SECURE_LTAB
(Fnc)
RENAME_ELEMENT (Cmd) SECURE_MACRO
(Fnc)
RENOVATE (Fnc) SECURE_TABLE
(Fnc)

SELECT (Qua) TAN_PT
(Qua)
SELECT_FROM_LTAB (Fnc) TAN_PT_PT
(Qua)
SELECT_KNOB (Qua) TB_GET_DRAW_VALUES
(Fnc)
SELECT_PORT (Qua) TB_SETUP_TABLE
(Fnc)
SEL_OLD (Qua) TECHO
(Fnc)
SGN (Afn) TEXT
(Cmd)
SHARED_PART (Qua) TEXTS
(Qua)
SHOW (Fnc) TEXT_ADJUST
(Fnc)
SHOW_PART (Fnc) TEXT_ANGLE
(Fnc)
SHOW_TABLE (Fnc) TEXT_ATTR
(Qua)
SHOW_TABLE_PAGE (Fnc) TEXT_COLOR
(Qua)
SIMILAR (Qua) TEXT_FILL
(Fnc)
SIN (Afn) TEXT_FORMAT
(Qua)
SLASH_TYPE (Qua) TEXT_FRAME
(Fnc)
SMALL (Qua) TEXT_LINESPACE
(Fnc)
SMOOTH (Qua) TEXT_RATIO
(Fnc)
SNID (Afn) TEXT_SIZE
(Fnc)
SOLID (Fnc) TEXT_SLANT
(Fnc)
SORT (Qua) THREE_PTS
(Qua)
SORT_LTAB (Fnc) TIME
(Afn)
SPLINES (Qua) TINPUT
(Fnc)
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SPOTLIGHT (Fnc) TITLE
(Qua)
SQL_QUERY (Fnc) TITLE_LAYOUT
(Qua)
SQR (Afn) TMENU
(Fnc)
SQRT (Afn) TONE
(Fnc)
STATLINE_RESET (Fnc) TOP
(Qua)
STORE_MACRO (Fnc) TRACE
(Fnc)
STORE_WINDOW (Fnc) TRACKING
(Qua)
STORE_WINDOWS (Qua) TRAP_ERROR
(Fnc)
STR (Afn) TREE
(Qua)
STRING (Qua) TRIANGLE_TYPE
(Qua)
STRUCTURE (Fnc) TRIM
(Afn)
STRUCTURES (Qua) TRUE
(Afn)
SUBPART (Qua) TRUNC
(Afn)
SUBSTR (Afn) TWO_PNT
(Qua)
SUBTRACT (Qua) TWO_PTS
(Qua)
SYMBOL (Qua) TYPE
(Afn)
TABLE (Qua) UINCHES
(Qua)
TABLET_RESET (Fnc) UM
(Qua)
TABLE_COLUMN (Fnc) UNDO
(Qua)
TABLE_LAYOUT (Cmd) UNITS
(Fnc)
TABLE_SCROLL_STEP (Fnc) UNRELEASE
(Cmd)
TABLE_TITLE (Fnc) UNRESERVE
(Cmd)
TAN (Afn) UNTIL
(Psc)
TAN2 (Qua) UP
(Qua)
TAN2_PT (Qua) UPC
(Afn)
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TAN3 (Qua) UPDATE_ELEMENT
(Cmd)
TAN_CENTER (Qua) UPDATE_SCREEN
(Fnc)

UPDATE_STATISTICS (Cmd) WHILE
(Psc)
UPPER (Qua) WHITE
(Fnc)
USER_TABLE (Qua) WIDTH
(Qua)
VAL (Afn) WINDOW
(Fnc)
VERSION (Fnc) WRITE_FILE
(Fnc)
VERSIONING (Qua) WRITE_LTAB
(Fnc)
VERTEX (Qua) X_OF
(Afn)
VERTEX_3D (Qua) YARDS
(Qua)
VERTICAL (Qua) YELLOW
(Fnc)
VIEW (Fnc) Y_OF
(Afn)
WAIT (Fnc) ZOOM
(Qua)
WARNING (Qua) Z_OF
(Afn)
WHERE_USED (Fnc) Z_POSITION
(Qua)

Creating Menus
To create a custom menu:

1. Pull down the Tools menu, click Customize and Customize Layout.
2. In the Customize Layout dialog box, click the Toolbar tab.
3. Click New.
4. Enter a name for the new menu in the New Toolbar dialog box.
5. Click OK to create a new (initially empty) container.
6. In the Customize Layout dialog box, click the Commands tab.
7. In the Categories pane, select the existing container from which you want to

copy commands.
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8. Select the required commands from the Buttons pane.
9. Drag these commands to the newly created container.
10. When the container holds all of the required commands, you can drag and

drop it to any location in the Creo Elements/Direct 2D Access user interface.

Adding Icons to the Toolbar
To add an existing icon (as a button) to the Creo Elements/Direct Drafting toolbar:

1. Pull down the Tools menu, click Customize and Customize Layout.
2. In the Customize Layout dialog box, click the Macro Commands tab.
3. Click Add New. In the Add New Macro Command dialog box:

• Enter a new name for the new macro.
• Enter a macro command (such as: delete all confirm) into the

Action Text field.
• Optionally, enter a tool tip (such as: Delete everyting on the

screen).
• Click Browse to select an icon.

4. Click OK to add the new macro command plus its associated icon to your list
in Customize Layout.

5. In Customize Layout, click the Commands tab.
6. Scroll down to the bottom of the Categories list until you see User Commands.
7. Click on User Commands. In the Buttons pane, select a button and drag it to

any point in the Creo Elements/Direct Drafting user interface (such as the
toolbar).

Creating Multi-Column Menus
Creo Elements/Direct 2D Access enables you to define and use your own
multiple-column menus.

Creating a Multi-Column Menu Definition File
To define a multiple-column menu, you create a simple text file which contains
the required definitions. This text file must contain the following sections:
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menu Contains global information like menu name, position etc.
rowX Defines which buttons (with their position) are contained in

row X (where X is a natural number). A separate section is
required for each row.

button_
btnname

Contains information about the button named btnname: label,
width and associated action. Each button requires its own
section.

Note
Section names are enclosed in square brackets.

Be sure to specify the filename extension mnu when saving your multi-column
menu definition file.

General Syntax
The general syntax of multi-column menu definition file is presented below.

[menu]
menu_name=MMM
menu_shown_rows=ROWS
menu_shown_columns=COLS
menu_positionx=POSX
menu_positiony=POSY
[rowX]
row_buttons=PP1;btn1#PP2;btn2...
[button_btn1]
button_label=LBL
button_width=WIDTH
button_actiontext=ACT
[button_btn2]
button_label=LBL
button_width=WIDTH
button_actiontext=ACT
[rowY]
...

where:
MMM stands for name of the menu. This name string will also be

displayed as the banner title of the menu window.
ROWS specifies the menu's height (in lines/rows).
COLS specifies the menu's width in characters.
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POSX specifies the horizontal position of the menu in pixels.
POSY specifies the vertical position of the menu in pixels.
PP1;btn1#PP2;btn2 There are two kinds of separators: # for buttons and ; for the

data (position and name) of a single button. In this example,
PP1 stands for the position of the first button (btn1), and
PP2 stands for the position of the second button (btn2). The
units are columns. One column is approximately equal to
the width of one character.

button_label This string will be shown on the button. The user will see
only this text.

button_width Width of the button in columns. 1 unit is equal
approximately to the width of 1 character.

button_actiontext This is the action text which will be executed when the
button is pressed. If the user need to open a submenu with
pressing this button then the action text should begin with
'##' and afterwards the name of the new multi column menu
file. The application will look for this file in the directory
from which is loaded the current menu.
The action text can have one more value — *X — which
means that when the user presses this button, the current
menu will be closed.

Note
Vertical and/or horizontal scrollbars are handled automatically.

Loading a Multi-Column Menu Definition File
To display and use a multi-column menu in Creo Elements/Direct 2D Access, load
its underlying menu definition file (extension mnu) in one of two ways:

• Enter LOAD_MULTICOL_MENU in the User Input Line in Then specify the
filename.

Alternatively:

• In Creo Elements/Direct 2D Access click Tools ▶▶ Customize ▶▶ Customize
Layout. Then click on the Multi Column Menus tab, click Add and select the
menu definition file.
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A
Absolute, 22
angles
measuring, 41

area
measuring, 42
properties, 42

arithmetic functions, 138
As Subpart, 22

B
beeper
switching on or off, 12

bisect
angle, 62
line, 62

boxes, parts as, 50
boxing
elements, 14

C
calculator, 44
catalog
sorted, 25

CATALOG command, 24
CATCH commands, 39
catch mode, 39
catch range
setting, 39

center point
creating, 31

centering
the drawing, 90

Change to Hidden, 58

changing
Creo Elements/Direct 2D Access,
122

Clipboard, 86
coloring
URLs, 72

command groups
CATCH, 39

command names, 132
commands
confirming, 18

commands vs functions, 138
Confirm command, 18
confirming
commands, 18
delete operation, 18
modify operation, 18

construction circles
by center and circumference point,
63
by center and element, 64
by diameter, 64
by radius or point, and two elements,
64
by radius, point, and element, 64
by three elements, 65
by three points, 63
concentric, 64
drawing, 63

construction geometry
selecting for deletion, 16

construction lines
a tangent to two circles, 63
at an angle, 62
bisecting a line, 62
bisecting an angle, 62
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by two points, 61
drawing, 61
horizontal, 61
parallel, 62
perpendicular, 61
tangent from a point to a circle, 63
vertical, 61

creating
a new center point, 31
a new window, 30
viewport, 33

Creo Elements/Direct 2D Access
basic working methods, 12

Creo Elements/Direct 2D Access
instance, 23
Creo Elements/Direct Annotation
changing colors and linetypes, 84
hidden lines, 83
introduction, 80
limitations, 81
loading a drawing, 82
preparing, 81
rules, 80
selecting a sheet or view, 82
Sheet Browser, 82
showing differences, 84
tangent lines, 83
view, 83

current
viewport, 30, 33, 35-36

cursor
setting the size, 44

customizing
Creo Elements/Direct 2D Access,
122
environment, 124
startup file, 131
the keyboard, 128

customizing Creo Elements/Direct 2D
Access, 19

D
DEFINE_KEY command, 128
defining
printing/plotting parameters, 88
your own units, 44

delete command, 12
deleting
all viewports, 35
elements, 12
general, 12
OLE object, 76
viewports, 35

dialog boxes
displaying directly, 108

dimensions
selecting, 17
showing, 37

displaying
infos, 37
point coordinates, 41
the origin, 44

distance
measuring, 40, 118

dot grid, 44
drawing
an isometric Ruler/Grid, 46
centering, 90
fitting a, 30
justifying, 90
loading, 115
panning across, 30
plotting, 85
positioning, 90
printing, 85

drawing file
opening in a new Creo Elements/
Direct 2d access instance, 24

drawing geometry
selecting, 16
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E
EDIT MACRO command, 127
EDIT_PART
Parent option, 50
Top option, 49

Editing Toolbar Items, 101
elements
adding to your selection, 13
boxing, 14
deleting, 12
enclosing within a polyline, 14
preselecting, 17
removing them from your selection,
14
selecting, 13
selecting all, 15

enclosing
customizing the, 124
elements, 14

environment
changing the, 125

exiting Creo Elements/Direct 2D
Access, 19

F
face
measuring the area, 42

faces, what are they?, 56
features
showing all, 36

file browser, 115
File Browser
opening a drawing, 21

files
how to find, 20

filing
introduction, 20

fitting, 30
Follow on/off
using, 45

font

importing, 20
fonts
system, 129
text, 129

function names, 132

G
generating
hidden lines, 58

Geo command, 16
global
selection, 12

graphics performance
enhancing, 37

grids
displaying, 44

H
hidden lines
displaying as dashed lines, 58
generating, 58
introduction, 56
plotting, 59

Hidden Mode
On or Off, 59

hiding
ruler/grid, 46

horizontal
measuring distances, 41

HP-GL file
importing, 28

I
icon
adding to toolbar, 106, 152
creating, 106

icons
in Part Browser, 52

importing
font, 27
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HP-GL file, 28
macro, 27

infos
displaying, 37
selecting, 15

INPUT MACRO command, 127
isometric ruler/grid
drawing, 46

item values, 26

J
justifying
the drawing, 90

K
Keep Scale, 22
key commands
customizing, 106

keyboard
customizing, 128

keywords
commands and functions, 138

L
language
switching, 10

layer
changing the color, 37

layers
selecting, 16
using the Show functions, 72

layout
loading, 109
resetting, 109
saving, 109

learning
Creo Elements/Direct 2D Access, 12

lengths
measuring, 40

line grid, 44

linesize
selecting, 16

linetype length, 96
Load File, 21
Load Files command, 67
LOAD MACRO command, 127
loading
introduction, 20
recently used drawing files, 23

loading and listing
text fonts, 129

loading drawings
File Browser, 21
in a new Creo Elements/Direct 2D
Access instance, 24
Navigator, 22

M
macro
importing, 27

macros
commands, 127
EDIT MACRO command, 127
INPUT MACRO command, 127
LOAD MACRO command, 127
loading, 127
running, 127
structure, 126
what are they?, 126
writing, 126
z-value in assembly, 58

Measure
calculator, 44

Measure function, 40
measurement units, 43
measuring
an example, 118
angles, 41
area properties, 42
distances, 40
horizontal distances, 41
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lengths, 40
radius, 41
vertical distances, 41

measuring a detail, 118
measuring distance, 119
measuring length
example, 118

menu items
customizing, 101

menus
custom, 102, 151
displaying or hiding, 101

minimum
z-value in assembly, 58

most recently used drawing files, 23
mouse buttons
customizing, 107

moving
OLE object, 76
the ruler, 45

multi-column menus, 152
multiple Creo Elements/Direct 2D
Access instances, 23

N
names
commands and functions, 132

Navigator
opening a drawing, 22

New command, 116

O
OLE object
activating, 77
deleting, 76
hiding and showing, 77
moving, 76
scaling, 76
to back, 77
to front, 77

OLE objects

linking and embedding, 74
Open, 21
origin
displaying, 44

P
panning
across a drawing, 30

parallel
construction lines, 62

parameters
printing/plotting, 88

parent part, 49
Part Browser
description, 52
icons, 52

part, parent, 49
parts, 48
editing, 49
Part Browser, 52
selecting, 16
tree, 12
viewing, 51

Parts
structure, 49

parts as boxes, 50
PARTS LIST
command, 50
Count option, 50
Tree option, 50

Paste, 18
pensize
selecting, 16

Pixmap Browser, 77
pixmap color
printing, plotting, 96

placing
the ruler/grid, 46

placing a detail in a viewport, 116
plot
fitting, 93
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plot transformation map, 94
plotter
selecting, 89

plotting
an example, 120
boxed area, 92
complete drawing, 91
current show attributes, 93
current viewport, 91
drawing, 93
drawings, 85
hidden lines, 58
linetype length, 96
multiple drawings, 97
pixmap color, 96
preview plot output, 97
Range, 91
scale, 92
scale factor, 92
starting output, 97
to a file, 89
truecolor, 94

plotting a drawing, 120
point coordinates
displaying, 41

points
showing, 36

port (viewports), 31
positioning
drawing in print/plot, 90

PreSelected, 17
Preview Print/Plot Output, 97
print configuration
example, 87

Print Manager, 86
printer
selecting, 89

printing
boxed area, 92
complete drawing, 91
current show attributes, 93
current viewport, 91

drawing, 93
drawings, 85
linetype length, 96
multiple drawing files, 97
pixmap color, 96
preview plot/print output, 97
range, 91
scale, 92
scale factor, 92
starting output, 97
to a file, 89
truecolor, 94

printing/plotting
settings, 88

pseudo commands, 138

Q
qualifiers, 138

R
radius
measuring, 41

range, 39
Range, 91
recalling
a window, 31

Redo, 18
redraw mode, 37
redrawing, 30
reference line
selecting, 16

relational operators, 25
Reset Show command, 68
restoring
last view, 30

revision checking, 66
loading files, 67
Reset Show, 68
Set Color, 68
Show Difference, 68

rotating
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the ruler/grid, 45
rotation
print/plot output, 91

ruler
displaying, 44
moving, 45

ruler/grid
drawing an isometric, 46
hiding, 46
placing, 46
rotating, 45
setting the spacing, 46
using, 44

S
scale
factor for plot, 92
setting, 92

scaling
OLE object, 76

screendunp, 98
Select command, 13
Select mechanism, 12
selecting
what is displayed, 35

selection
a vertex, 15
boxing elements, 14
confirming, 18
construction geometry, 16
dimensions, 17
drawing elements, 13
drawing geometry, 16
elements within a polyline, 14
general, 12
global, 12
infos, 15
layers, 16
linesize, 16
parts, 16
pensize, 16

reference lines, 16
removing elements, 14
subtracting elements, 14
subtree, 16
text, 16
URLs, 17

Set Color command (revision
checking), 67
setting the units of measurement, 43
Sheet Browser, 82
Show
functions with layers, 72

SHOW
All option, 51
Boxed option, 51
function, 35
Part option, 50

Show Difference command, 68
Show Hidden, 59
Show, using, 119
showing
all features, 36
dimensions, 37
points, 36

sorted catalogs, 25
SPOTLIGHT ON/OFF command, 54
spotlighting, 54
starting Creo Elements/Direct 2D
Access, 9
startup file
customizing, 131
editing, 131

storing
a window, 31

structure
macros, 126

subtree
selecting, 16

switching
URLs on and off, 72

system fonts, 129
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T
tangent
constructing, 63

text
selecting, 16

text fonts
loading and listing, 129

toolbar
adding a button, 152
adding items, 102
creating, 102
loading, 109
saving, 109

toolbar items
editing, 101

truecolor plotting, 94
truecolor printing, 94
TrueType font
importing, 27
Resolution, 27

tutorial
using Creo Elements/Direct 2D
Access, 114

U
Undo, 18
Unicode, 110
units of measurement, 43
URL
color, 72

URLs
selecting, 17

user interface
classic, 11
customizing, 100

using
Show commands, 119
viewports, 116

V
values
Z, 56

vertex
selecting a, 15
show, 36

vertical
measuring distances, 41

vertices
show, 36

View command
Parent option, 51
Top option, 51

View commands
parts, 51

VIEW commands, 51
viewport
changing size, 34
creating, 33
creating, example, 115
deleting, 35
making it current, 33
maximizing, 34
moving, 34
placing a detail, 116
redrawing, 34
settings, 35

W
what are macros?, 126
wildcards, 26
window
creating, 30
recalling, 31
restoring last view, 30
storing, 31
using normal functions, 30
zooming, 30

windows
multiple Creo Elements/Direct 2D
Access instances, 23
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working
basic methods, 12

writing
macros, 126

Z
z-value
checking, 57
checking maximum, 58
checking minimum, 58
of a shared part, 58
what is it?, 56

zooming
in or out, 30
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